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1. About this Guide 

This section provides a brief description of this guide and how to use it. 

1.1 Purpose 

The purpose of this guide is to describe the Celigo cytometer administrative 
procedures. The procedures are those performed to ensure proper Celigo 
cytometer functionality, reasonable performance, and the ability to retrieve 
backup files. The procedures are those performed after Celigo cytometer 
installation and testing. 

1.2 Conventions used in this Guide 

This section describes the symbols and signal words used in this guide. 

1.2.1 Hazard Symbols 

This guide uses symbols and associated signal words to communicate safety 
hazards. The hazard symbols, listed in Table 1, allow for easy and rapid 
recognition of the hazard type.  

The signal word definitions, listed in Table 2, comply with the ANSI Z535.4 
standard for product safety signs and labels. 

Table 1. Hazard Symbols 

Symbol Hazard 

 

Voltage or electrical current 

 

Moving parts (pinch point 
hazard) 

 

General 

Table 2. Hazard Severities 

Signal Word Severity 

DANGER 
Indicates an imminently hazardous situation that will result in 
severe personal injury or death if it is not avoided. 

WARNING 
Indicates a potentially hazardous situation that could result in 
severe personal injury or death if it is not avoided. 
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Signal Word Severity 

CAUTION 

Indicates a potentially hazardous situation that may result in 
minor or moderate personal injury. It may also alert against 
unsafe practices. These include practices that may result in 
system damage, data corruption, data loss, or settings loss. 

1.2.2 Other Symbols 

This guide uses the additional symbols and signal words shown in Table 3. 

Table 3. Additional Symbols 

Symbol Meaning 

 

A note. Indicates helpful information for the topic or step 
being described. 

1.3 Safety Precautions 

This section describes the precautions for safe operation of the Celigo cytometer. 

1.3.1 Electrical Safety 

The Celigo cytometer contains voltages and electric currents that are potentially 
hazardous. Under normal circumstances, the user and other persons in the 
vicinity of the Celigo cytometer are protected from accidental contact with these 
electrical hazards by physical barriers (exterior panels and access doors) and by 
electrical grounding of the instrument. 

To reduce the risk of electric shock: 

• Ensure that all three-pronged power cords from the Celigo cytometer (total 
of 3 for instrument, workstation and monitor) are plugged into properly 
grounded 100 – 240 VAC receptacles only. 

• Do not perform repairs on or within the Celigo cytometer. Only qualified 
service personnel should perform repairs. 

If you are uncertain about any of the safety issues highlighted in this manual or 
have additional safety concerns, do not hesitate to contact Nexcelom Customer 
Service directly, with your questions or concerns, before attempting to service the 
Celigo cytometer. 
 

 

WARNING: Use this product in the manner described 
in this document, and while observing all specified 
safety precautions. When used other than as specified, 
the safety features may be impaired or defeated. 
Failure to adhere to the safety precautions and/or 
procedures outlined in this document may result in 
system failure, personal injury, or death, for which 
Nexcelom shall not be held liable under any 
circumstances. 
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WARNING: Risk of electric shock! The Celigo 
cytometer contains voltages and electric currents that 
are potentially hazardous. To reduce the risk of electric 
shock, do not remove instrument covers without 
proper training. Qualified service personnel should 
perform all repairs. 

1.3.2 Moving Part Hazards 

The Celigo cytometer contains mechanical components that move within the 
instrument. Some of these components move in a linear fashion (for example, 
the x-axis and y-axis movements of the specimen stage), and some of these 
components have a rotational motion (for example, the galvanometer motors). 

The Celigo cytometer’s moving components can pose risks of pinching, crushing, 
cutting, twisting or entrapping body parts, particularly hands and fingers.  To 
avoid injury by the instrument’s moving components, you must observe the 
following precautions. 

• While an application is executing, keep the access door closed. 

• While an application is executing, the various mechanical components of the 
instrument can move at any time, without warning. Do not reach into the 
instrument while an application is executing, unless the application 
specifically requests that a new specimen plate be loaded onto the stage at a 
particular time. 

• Do not reach into the instrument to remove or load a specimen plate while 
the stage is still moving.  Wait until the stage has come to a complete stop, 
before reaching into the instrument. 

• Keep clothing, jewelry, hair, and other loose materials clear of the 
instrument’s mechanical components.  Moving components can catch hold of 
such loose materials, thereby forcing a body part into a dangerous position. 

 

CAUTION: The Celigo cytometer contains moving 
mechanical components that are capable of causing 
bodily harm. Do not reach into the instrument while 
parts are moving.  Keep clothing, jewelry, hair, and 
other loose materials clear of mechanical components. 

1.4 Disposal Compliance 

 

Nexcelom Bioscience complies with European Union Waste 
Electrical and Electronic Equipment (WEEE) Directive 
2002/96/EC. The Celigo cytometer, as supplied by 
Nexcelom, contains Electrical and Electronic Equipment 
(EEE) and is suitable for recycling, provided it is not 
contaminated with hazardous substances. 

If disposal is needed, contact Nexcelom Customer Service 
for further information, assistance, and costing for disposal. 
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1.5 Technical Assistance 

Contact Nexcelom Customer Service for further information: 

Nexcelom Bioscience, LLC. 
Customer Service 
360 Merrimack St. Building 9 
Lawrence, MA 01843, USA 

• From the United States: 
E-mail: support@nexcelom.com 
Phone: +1 978-327-5340 

• From Europe: 
E-mail: support@nexcelom.co.uk 
Phone: +44 (0) 161 232 4593 

If you have a technical question that you are unable to answer after consulting 
the documentation provided with the Celigo cytometer, please contact Nexcelom 
for assistance. So that we may assist you in the most expeditious manner 
possible, please generate and send an error report as follows: 

Using the Software Help feature 

1. At the upper right corner of the Start tab, select Help > Generate Diagnostic 
File (Figure 1). 

Figure 1. Generate Diagnostic File 

 

2. Perform the prompt instructions. 

3. Save the resulting error report to your desktop. 

4. Attach the error report to an e-mail and send it to the applicable e-mail 
address according to the above list. If it is too large to attach to an e-mail 
then please upload to a 3rd party file transfer site (such as Dropbox, Google 
Drive, etc.) or simply contact Nexcelom Customer Service for temporary use 
of our support Dropbox account. 

mailto:support@nexcelom.com
mailto:support@nexcelom.co.uk
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2. Startup and Shutdown 

This section provides the procedures for starting up and shutting down the Celigo 
cytometer. 

2.1 Startup 

To start up the Celigo cytometer system 

1. Turn on the main power button on the front of the instrument. 

Note: The instrument’s front display panel should light up. 

2. Turn on the Celigo computer. 

3. Log in to the computer. 

4. Launch the Celigo application. 

The Celigo program opens and the Home tab appears. 

2.2 Shutdown 

To shut down the Celigo cytometer system 

1. In the Celigo application, click Unload Plate (Figure 2). 

Figure 2. Unload Plate Button 

 

2. An Unload Plate window appears (Figure 3). 

Figure 3. Unload Plate Window 

 

3. Remove the plate or flask from the instrument. 

4. In the Unload Plate window, click OK or Cancel. 

5. Exit the Celigo program by clicking the X icon in the upper right corner of the 
window. 

6. Shut down the computer using the Windows Start/Shutdown menu. 
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NOTE: It is recommended that you only periodically 
shut down the computer. Keeping it on will allow for 
defragmentation, which helps Celigo cytometer 
performance. 

7. Switch off the instrument power button.  
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3. Managing Users 

 

NOTE: Managing users requires Local Administrator 
permissions. 

You manage users in the User Management window, accessed from the 
Administration menu (Figure 4) on the Start tab. Managing users consists of 
adding, deleting, and changing user profiles. 

Note:  Administration tab is accessible from the HOME tab.  

Figure 4. Administration Menu 

 

After a Local Administrator creates a user, that user can then login to the Celigo 
software using those credentials.  Feature access and data access may be 
limited depending on the role associated to the user and the permissions 
provided to the user to various folders.  For the additional information on folders, 
see section 5. 

3.1 Adding a User 

Perform the following steps to add a user profile to the database. 

To add a user 

 

NOTE: Adding users requires Local Administrator 
permissions. 

1. Log in to the Celigo application. 

2. In the Start tab, at the top of the Celigo user interface, select Administration 
> Manage Users (Figure 4 above). 

The User Management window appears (Figure 5) with the Users tab 
displayed. 
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Figure 5. User Management Window 

 

 

 

3. In the upper right corner of the User tab, click the + button. The Add New 
User dialog box appears (Figure 6). 

Figure 6. Add New User Dialog Box 

 

4. Fill in the following fields: 

• First Name 

• Last Name 

• Formatted Name (optional) 

• User Name – Fill in your login ID 

• Password Duration (Days) (optional) – 0 means forever 

• Password Expiration Date (optional) 

• Password (optional) 

• Password Confirmation (optional) 

Personnel logged in with 
Local Administrator 
permissions can view a list 
of all users. Scientists can 
view only their own user 
account. 

Only personnel logged in 
with Local Administrator 
permissions can view a 
User Groups tab. 

Only personnel logged in with  
Local Administrator permissions can view 
the Add User and Remove User buttons. 

Only Celigos configured with a network 
database and personnel logged in with Local 
Administrator permissions can view a User 
Sessions tab. 
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• Permissions: Select one of the following: 

− Scientist: Can view and edit only his or her data in their own user 
folder or folders the user was provided permissions to. 

− Local Administrator: Can view and edit all user folders and their 
scans, settings, and analyses. Also can perform administrative tasks, 
such as adding users and importing/exporting plate profiles. 

An example of a completed Add New User dialog box is shown in Figure 7. 

 

 

NOTE:  Keep the default Password Duration as 0 if 
you want the password to continue indefinitely, 
without expiring. 

Figure 7. Add New User Example 

 

5. Click Save. 

The system adds the user to the database with full permissions to their user 
folder. In the User Management window, an icon for the user (their user 
folder) appears in the Users tab, and a listing for the user appears in the 
Groups tab. The new user is listed as a Non Group Member because new 
users have not yet been assigned to a group. An icon for the user’s folder will 
also appear in the Data Management screen. The results of adding a user 
are shown in Figure 8. 
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Figure 8. Added User 

New User Listing in User 
Management Window’s 
Users List 

New User Listing in User Management 
Window’s Non Group Members List 

New User Listing in Data 
Management Screen 

  

 

6. To confirm that the user has been added to the database: 

• Select Administration > Manage Users. 

The User Management window appears. 

• Confirm that the user’s name is listed in the Users and User Groups 
tabs (Figure 8 above). 

• Navigate to the Home tab and click Manage Data. 

The Data window appears. 

Confirm that the newly added user’s name appears in the Non Group 
Members list in the right-hand pane, for potential adding to a group. 

Figure 9 illustrates user permissions. In the Data window on the left, the logged-
in user has Local Administrator permissions and therefore can view the icons 
(user folders) representing all users and can also view all folders. On the right, 
the logged-in user has Scientist permissions and therefore is limited to viewing 
only their own user folder and any shared folders the user has at least read 
access to. 
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Figure 9. User Permissions 

Local Administrator  Scientist 

 

 

 

3.2 Removing a User 

Perform the following steps to permanently remove a user profile from the 
database. To temporarily remove a user profile from the database for possible 
future reactivation, see Deactivating a User in section 3.3. 

To remove a user 

 

NOTE: Removing users requires Local Administrator 
permissions. 

1. Log in to the Celigo application. 

2. In the Start tab, at the top of the Celigo user interface, select Administration 
> Manage Users (Figure 4 above). 

The User Management window appears (Figure 5 in section 3.1) with the 
Users tab displayed. 

3. In the Users list in the left pane, left-click the name of the user to be 
removed. 

4. In the upper right corner of the Users tab, click the X button. 

A confirmation message appears asking if you are sure you want to remove 
the user. 

5. Click Yes. 

The user list updates as follows to reflect the change: 

• If the user does not have any associated plates/scans, the user name is 
removed (Figure 10a). 

• If the user has associated plans/scans, a prompt appears (Figure 10b). 

• Clicking Yes will delete all the contents along with the user. 

• Clicking No will transfer all the data belonging to the user into the 
currently logged in user account’s folder. 

• Clicking Cancel will cancel the delete user operation. 

The logged-in user in this Data window has Scientist 
permissions and therefore cannot view the user 
folders for the other two users and the shared folder 
that the user does not have read access to. 
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Figure 10a. Removing a User From the Database 

Before Confirm After Confirm 

   

Figure 10b. Removing a User from the Database with Associated Data 

 

3.3 Deactivating a User 

Perform the following steps to deactivate a user profile. To permanently remove 
a user profile, see Removing a User in section 3.2. 

To deactivate an existing user profile 

 

NOTE: Deactivating users requires Local 
Administrator permissions. 

1. Log in to the Celigo application. 

2. In the Start tab, at the top of the Celigo user interface, select Administration 
> Manage Users (Figure 4 above). 

The User Management window appears (Figure 5 in section 3.1) with the 
Users tab displayed. 

3. In the Users directory in the left pane, left-click the name of the user to be 
edited. 

4. Click De-Activate User on the right-hand pane. 
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The users name in the user list changes to bold text with an asterisk (*). The 
asterisk indicates that the profile for the user has changed in the current 
session. 

5. At the bottom of the Users tab, click Update All Changes. 

The system applies the change. The user’s name in the user list changes to 
red (Figure 11) and the asterisk disappears. The red indicates a 
deactivated user.  

Figure 11. User Profile Deactivation Indicated 

Before Selecting Update All 
Changes 

After Selecting Update All 
Changes 

  

3.4 Editing an Existing User Profile 

To edit an existing user profile 

 

NOTE: Editing user profiles requires Local Administrator 
permissions. 

1. Log in to the Celigo application. 

2. In the Start tab, at the top of the Celigo user interface, select Administration 
> Manage Users (Figure 4 above). 

The User Management window appears (Figure 5 in section 3.1) with the 
Users tab displayed. 

3. In the Users directory in the left pane, left-click the name of the user to be 
edited. 

The user profile appears in the right-hand pane. 

4. Edit the user profile as needed. 

The user’s name in the user list (appears as bold text and with an asterisk (*) 
after it. The asterisk indicates that the profile for the user has changed in the 
current session. 

5. Commit the edited user profile to the database by clicking Update All 
Changes. 
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The system applies the changes. The change is no longer bold and the 
asterisk disappears (Figure 12). 

Figure 12. User Profile Change Indicated 

Before Selecting Update All Changes After Selecting Update All Changes 

  

 



Nexcelom Celigo® Cytometer Administrator Guide Managing Groups 

21 of 136 

4. Managing Groups 

 

NOTE: Managing groups requires Local Administrator 
permissions. 

You manage groups in the User Management window, accessed from the 
Administration menu (Figure 4 above) on the Start tab. Managing groups consists of 
adding, editing, and removing user groups, and adding and removing users to/from 
user groups. 

After a Local Administrator creates a group, any user can then use folders to limit 
access to data files and folders by those groups. For the instructions to use folders, 
see section 5. 

4.1 Adding a User Group 

To add a user group 

 

NOTE: Adding user groups requires Local 
Administrator permissions. 

1. Log in to the Celigo application. 

2. In the Start tab, at the top of the Celigo user interface, select Administration > 
Manage Users (Figure 4 above). 

The User Management window appears (Figure 5 in section 3.1) with the Users 
tab displayed. 

3. Click the User Groups tab (Figure 13). 

 

NOTE: The User Groups tab is available only to users 
who have Local Administrator permissions. 

Figure 13. User Groups Tab 
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4. In the upper right corner of the User Groups tab, click the + symbol. 

The New User Group dialog box appears (Figure 14). 

Figure 14. New User Group Dialog Box 

 

5. In User Group Name, enter the desired user group name. 

6. In Description, enter a description of the group if needed (Figure 15). 

Figure 15. New User Group Entries 

 
 

 

NOTE: If a user group by the entered name already 
exists, the Create button becomes disabled and a 
message appears when you hover the mouse cursor 
over the Create button. 

7. Click Create. 

The new user group appears in the User Groups list in the left-hand pane (Figure 
16). 
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Figure 16. User Group Added 

 

4.2 Adding Users to a User Group 

It is convenient to add individual users to a user group. This will allow users to set up 
folders for multiple users to access. 

To add users to a user group 

 

NOTE: Adding users to a user group requires Local 
Administrator permissions. 

1. Log in to the Celigo application. 

2. In the Start tab, at the top of the Celigo user interface, select Administration > 
Manage Users (Figure 4 above). 

3. Click the User Groups tab. 

4. In the User Groups list in the left-hand pane, click the User Group to which you 
want to add the user. 

5. In the Non Group Members list in the right-hand pane, click the user that you 
want to add to the selected group. 

• To select multiple individual users, use Ctrl+click. 

• To select multiple users in a range, use Shift+click. 

6. Click the < button. 

The user name moves from the Non-Group Members list to the Group Members 
list in the middle pane. 

In Figure 17, the users named Demo User and Local Administrator have been 
added to the group named User Group 2. Users named User 1, User 2, and 
User 3 have not yet been assigned to groups. 
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Figure 17. Users Added to a User Group 

 

7. Repeat steps 5 and 6 as needed for each user that you want to add to the 
selected group. 

4.3 Removing Users from a User Group 

To remove users from a user group 

 

NOTE: Removing user from a user group requires 
Local Administrator permissions. 

1. Log in to the Celigo application. 

2. In the Start tab, at the top of the Celigo user interface, select Administration > 
Manage Users (Figure 4 above). 

The User Management window appears (Figure 5 in section 3.1) with the Users 
tab displayed. 

3. Click the User Groups tab. 

4. In the User Groups list in the left-hand pane, click the User Group from which you 
want to delete the user. 

In the Group Members list in the middle pane, click the user that you want to 
delete from the selected group. 

• To select multiple individual users, use Ctrl+click. 

• To select multiple users in a range, use Shift+click. 

5. Click the > button. 

The user name moves from the Group Members list to the Non-Group Members 
list in the right-hand pane. 

4.4 Removing a User Group 

Perform the following steps to remove a user group from the database. 
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To remove a user group 

 

NOTE: Removing a user group requires Local 
Administrator permissions. 

1. Log in to the Celigo application. 

2. In the Start tab, at the top of the Celigo user interface, select Administration > 
Manage Users (Figure 4 in section 3). 

The User Management window appears (Figure 5 in section 3.1) with the Users 
tab displayed. 

3. Click the User Groups tab. 

4. In the User Groups list in the left-hand pane, click the name of the user group 
that you want to remove. 

5. In the upper right corner of the User Management window, click the X button. 

A confirmation message appears asking if you are sure you want to remove the 
user group. 

6. Click Yes. 

The User Groups list in the left-hand pane updates to reflect the deleted user 
group.
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5. Managing User Sessions 

You manage user sessions in the User Management window, accessed from the 
Administration menu (Figure 4 above) on the Start tab. Managing user sessions 
consists of viewing user sessions and their locked data, and terminating user 
sessions. 

Figure 18. User Sessions Window 

 

5.1 Viewing User Sessions 

To view a user session 

 

NOTE: Viewing user sessions requires a network database 
setup and Local Administrator permissions. 

1. Log in to the Celigo application. 

2. In the Start tab, at the top of the Celigo user interface, select Administration 
> Manage Users (Figure 4 above). 

The User Management window appears (Figure 5 in section 3.1) with the 
Users tab displayed. 

3. Click the User Sessions tab (Figure 18). 

 

NOTE: The User Sessions tab is available only to users 
who have a network database setup and Local 
Administrator permissions. 

 

 

NOTE: Managing user sessions requires a network 
database setup and Local Administrator permissions. 
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• Each entry in the user sessions table represent a current connection to 
the network database.   

Each session specifies the: 

− logged in user 

− machine name the session originated from session duration 

− plate details for any plate currently in use by the session  

 

NOTE: Whenever a user loads or views a plate, that 
plate is locked preventing others on other machines 
from loading or viewing the same plate.  This locking 
mechanism is performed to protect the data while in 
use.  In addition, various data management functions 
will not be allowed for data that is locked until it is 
unlocked.  To unlock data, the user would have to 
unload the plate/scan or logout.  In addition, a local 
administrator can terminate a user session.  To 
terminate a user session, please refer to section 5.2. 

4. To refresh the user sessions at any time, click the refresh button found at the 
top right corner of the window. 

Figure 19. User Session Refresh Button 

 

 

5.2 Terminating a User Session 

To terminate a user session 

 

NOTE: Terminating user sessions requires a network 
database setup and Local Administrator permissions. 

 

NOTE: Whenever a user loads or views a plate, that 
plate is locked preventing others on other machines 
from loading or viewing the same plate.  This locking 
mechanism is performed to protect the data while in 
use.  In addition, various data management functions 
will not be allowed for data that is locked until it is 
unlocked.  To unlock data, the user would have to 
unload the plate/scan or logout.  In addition, a local 
administrator can terminate a user session.  To 
terminate a user session, please refer to section 5.2. 

1. Log in to the Celigo application. 

2. In the Start tab, at the top of the Celigo user interface, select Administration 
> Manage Users (Figure 4 above). 

3. Click the User Sessions tab. 
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4. In the window, select the user session to be terminated and then click the 
Terminate button to terminate the selected user session. 

Figure 20. Terminate User Session Button 
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6. Managing Folders 

Any user can create folders to both organize files and to limit access to the 
folders and their contents by existing users and user groups. You do this using 
the Folder view found in the Data Management screen from the Start tab’s 
Manage Data button. 

Folders are displayed in the Data and Settings tabs (Figure 21). 

If the user has Local Administrator permissions, the user will have full 
permissions to view all folders. All other users will be able to view a folder only if 
the user has been given permission to view it. A user has access to a data file or 
folder by being associated with it either directly or indirectly by means of a user 
group. A user’s access rights to a shared folder depends on the association a 
user has with the folder. 

The folder view in the left pane displays the existing folders that the logged-in 
user has permissions to access (by means of the Scientist or Local Administrator 
permission selected when the user profile was created). When a folder is 
checked in the left pane, the data or settings contained in the folder appears in 
the right-hand pane for interaction. 

Figure 21. Data Window 

 

6.1 Adding a Folder 

Any user can create (add) a folder to set up permissions to the folder and its 
contents. The permissions affect whether personnel will be able to view or take 
other actions on the folder and its contents. 

To add a folder 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 21 above). 

3. Near the top of the Data Management screen, in the left-hand pane, click the 
new folder symbol found within the folder view (Figure 22). 

This pane displays 
the data that 
corresponds to the 
item(s) selected in 
the left pane. You 
interact with data 
using this pane.  
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Figure 22. New Folder Button 

 

The New Folder window appears (Figure 23). By default, the Name field is blank 
and the Permissions field displays Full permissions for the currently logged in 
user. 

Figure 23. New Folder for Setting Up Permissions 

 

4. In Folder Name, type a unique folder name (a folder name that is not already 
in use). 

• If the typed folder name is not unique, the folder name will display in red 
and the OK button will be greyed out. 

5. In Permissions, change the permission for the folder as desired. 

6. Click Add. 

7. The Add User Group / User dialog box appears (Figure 24). 

Figure 24. Add User Group / User Dialog Box 

User Groups Tab Users Tab 

  



Nexcelom Celigo® Cytometer Administrator Guide Managing Folders 

33 of 136 

8. Click a single user group or user that you want to associate with the folder. 

9. In the Add User Group / User dialog box, click OK. 

The name of the user group or user that you want to associate with the folder 
appears in the New Folder dialog box. 

10. Repeat steps 8 and 9 as needed to associate more user groups and users 
with the folder. 

11. In the New Folder dialog box, click OK. 

The new folder name appears in the Data window’s left pane. Figure 25 
shows users and groups with the four different types of permissions. 

Figure 25. Permission Types 

 

• Read – The folder and its contents can be viewed only. 

• Read / Write – The folder and its contents can be viewed, and can be 
modified by only adding to the contents. 

• Read / Write / Delete – The folder and its contents can be viewed, and 
can be modified by both adding and removing contents from the folder, 
but the folder itself cannot be deleted. 

• Full – In addition to the access given in Read / Write / Delete, folder 
associations and permissions can be modified, and the folder itself can 
be deleted. 

If the user has Local Administrator permissions, the user has full permissions 
to all folders. 

6.2 Changing Permissions to a Folder 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 21 above). 

3. Click the folder for which you want to change the permissions. 
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4. At the top of the Data Management screen, in the left-hand pane, click the 
Modify Folder button (Figure 26). 

 

NOTE:  You can click this button only if the selected 
folder is a shared folder and you have full permissions 
to the folder (by having been given Full permissions or 
by being an Administrator). 

Figure 26. Modify Folder Button 

 

The Modify Folder dialog box appears (Figure 27). 

Figure 27. Modify Folder 

 

5. In Permissions, change the selection as needed. 
6. Click OK. 

6.3 Deleting a Folder 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 21 above). 

3. Click the folder that you want to delete. 

4. At the top of the Folder view in the Data Management screen in the left-hand 
pane, click the Delete Folder button (Figure 28). 

Figure 28. Delete Folder Button 

 



Nexcelom Celigo® Cytometer Administrator Guide Managing Folders 

35 of 136 

 

NOTE:  You can click this button only if the selected 
folder is a shared folder and you have full permissions 
to the folder (by having been given Full permissions or 
by being an Administrator). 

A confirmation message appears about deleting the folder.  

5. Click Yes. 

One of the following occurs: 

• If the folder contains no data or settings, the system deletes the folder. 

If the folder contains data or settings, a confirmation message appears asking 
whether you would like to also delete the contents of the folder, transfer the 
contents of the folder to their own user directory, or cancel the delete operation 
(Figure 29). 

Figure 29. Delete Folder Contents Confirmation Message 

 

6. Do one of the following: 

• If you want to delete the contents of the folder, click Yes. 

The folder and its data are deleted. 

• If you want to transfer the contents of the folder to your user directory, 
click No. 

The folder is deleted and the contents are moved to your user directory.



 

36 of 136 

 
This page intentionally blank 

 



Nexcelom Celigo® Cytometer Administrator Guide Managing Report Templates 

 

37 of 136 

7. Managing Data 

Figure 30. Data Management Screen 

 

The Data Management is broken into five separate views: Data, Projects, 
Settings, Report Templates and Summary.  The Data Tab displays all the data 
currently stored in the Celigo database.  Data contains all Plates, Scans, and 
Scan Results.  Data is displayed in a grid utilizing a tree like structure to display 
the relation between plates, scans, and scan results. 

Figure 31. Data Management Tabs 

 

7.1 Searching for Data 

The default setting for the Data Tab is to display all the data the user has access 
to.  If the user would like to limit what is displayed, the user can modify the filter 
settings found on the left side of the screen. 
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Figure 32. Data Searching Filters 

 

Filters are broken up into 5 sections:  Search, Folders, Plate, Scan, and Result.   

Search 

The Search section appears just above the Folders section.  This section is 
primarily an open text field that allows the user to type in any text to match a 
plate barcode, descriptions for any data (plates, scans or scan results), or tags 
for any data (plates, scans, or scan results).  If desired, a checkbox exists to limit 
the filter to only data related tags. 

Folders 

The Folders section appears underneath the Search section and displays all 
folders the logged in user has access to.  This section allows the user to add, 
modify, or delete folders as well as selecting which folders to display data for.  If 
a folder is checked, the data contained within the folder is displayed.  If a folder is 
not checked, the data contained within the folder is not displayed.  The Check All 
and Uncheck All buttons (Figure 33) exist to quickly perform batch 
checking/unchecking.  If a user wishes to display a single folder, the user double 
clicks on any folder to check that folder and uncheck all others. 

Figure 33. Check/Uncheck All Buttons 

 

Controls for creating, modifying, and deleting folders (Figure 34) exist in the 
Folders section.  This functionality works in the same manner as in prior versions 

 

 

 

 

Search Section 

Folders Section 

Plate Filters Section 

Scan Filters Section 

Result Filters Section  
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of Celigo.  Additional details can be found in section 6 of the Celigo Administrator 
Guide. 

Figure 34. Folder Control Buttons 

 

Plate Filters 

The Plate Filters section appears just below the Folders section.  This section 
allows a user to filter plates by plate type (also referred to as the plate profile), 
project, plate creator, and whether or not the plate has any associated scans. 

Scan Filters 

The Scan Filters section appears just below the Plate Filters section.  This 
section allows a user to filter scans by the number of channels used when the 
scan was acquired, image format of the images in the scan, time frame the scans 
were acquired, plate creator, and whether or not the scan has any associated 
scan results. 

Result Filters 

The Result Filters section appears just below the Scan Filters section.  This 
section allows a user to filter scan results by the scan’s application type, time 
frame the scan results were generated, and scan result creator. 

Refreshing Controls 

If a user modifies any setting while the Auto Refresh checkbox (Figure 35) is 
checked, a refresh operation will occur, and the software will display the updated 
data set matching the new filter criteria on the right-hand side of the screen. 

Figure 35. Auto Refresh Checkbox 

 

If the Auto Refresh checkbox (Figure 35) is not checked, no refresh operation will 
occur until the user clicks the Refresh button (Figure 36) located at the bottom 
right hand side of the screen. 

Figure 36. Refresh Button 

 

To search for data (plates, scans, scan results)  

1. Log into the Celigo application.  

2. In the Start tab’s task screen, click Manage Data. The Data Management 

screen appears. 

3. Adjust any search and filter entries as applicable (see descriptions 

above). 

4. Click Refresh.  The Data display on the right side of the screen will 

display any found data results matching the search parameters/filters 

specified. 

 

NOTE:  If the Auto Refresh checkbox is checked, step 4 
above is not necessary.  A refresh operation will be invoked 
for every change setting as a setting is changed. 
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7.2 Clearing Search Selections 

The Reset Filters button (Figure 37) provides the user the ability to revert all the 
filters back to default settings which will display all data on the right-hand side of 
the screen after a refresh is invoked. 

Figure 37. Reset Filters Button 

 

To clear search settings for data (plates, scans, scan results)  

• In Data Management screen in the Data Tab, click the Reset Filters 

button. 

7.3 Updating Search Selections 

The Plate, Scan, and Result Filters are set to have their selectable options and 
limits based on the entire database. Plate Types will therefore only display plate 
types that are existing in the database.  Created By filter and all other filters 
function similarly.  When the Celigo is connected to a network database (where it 
is possible for other users to be changing the data in the database you are 
connected to) the limits of your filters can change from when they have been 
loaded.  The Refresh Filters button (Figure 38) allows a user to refresh the limits 
of all their filters to the current state of the database. 

Figure 38. Refresh Filters Button 

 

 

NOTE:  The Refresh Filters button is only displayed 
when the Celigo is connected to a network database.  
This option is not present for Celigo connected to a 
local database. 

To update the bounds of the search settings for data (plates, scans, scan 
results)  

• In Data Management screen in the Data Tab, click the Refresh Filters 

button. 

7.4 Viewing Data 

Data is displayed in a grid on the right-hand side of the screen (Figure 39). The 
grid utilizes a tree like structure to display the relation between plates, scans, and 
scan results. This section of the screen allows the user to view data that matches 
the specified filters and enables the user to perform various functions on 
the data. 
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Figure 39. Data Display Grid 

 

The data displayed in the grid is organized by plate.  Each plate can be 
expanded to display any scans that were acquired for the plate.  Each scan can 
also be expanded to display any scan results that were generated for the scan.  
The grid is organized into columns that display various properties of the plates, 
scans, and scan results.  These columns include: Name, Folder, Number of 
Channels, Image Format, Application, Created By, Description, and Tags. 
Information within columns will be displayed as applicable.  All columns are 
sortable except for the Tags column. 

The button strip (Figure 40) at the bottom of the data display section displays the 
plate count, scan count, and scan result count of the found matching data set.  
Each data set is broken up into pages and only one page can be viewed at a 
time.  On the right-hand side of the strip, controls exist to allow the user to 
navigate to different pages of the data set.  A user can type in a page number to 
navigate to, click on a button with an arrow and a line to navigate to the first or 
last pages, or click on a button with just an arrow to navigate to the previous or 
next page.  If an operation is not allowed, the buttons will become disabled. 

Figure 40. Data Display Button Strip 

 

You can expand and collapse the line items (data view) showing the plate listings 
containing the scan images and scan data (scan results). 

To expand the data view 

• With the Data tab selected in the Data Management screen, click the 
Expand All arrow at the top right of the screen (Figure 41). 

Figure 41. Expand All Arrow 

 

To collapse the data view 

• With the Data tab selected in the Data Management screen, click the 
Collapse All arrow at the top right of the screen (Figure 42). 
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Figure 42. Collapse All Arrow 

 

7.5 Exporting Data Report 

The Data Tab allows a user to copy the current data result set as an image, text, 
or as an exported CSV file. 

Figure 43. Copy Dropdown Menu 

 

The Copy As Image button allows the user to copy the displayed data (as seen 
on the screen) as an image to the clipboard. 

The Copy As Text button allows the user to copy all data (in all pages) as text to 
the clipboard. 

Figure 44. Export Button 

 

The Export button (Figure 44) allows the user to save a text file of all data (from 
all pages) to disk. 

7.6 Selecting Data 

Each data item (plate, scan, scan result) can be checked or unchecked.  
Checking a data item marks the data item to be included for a data operation if 
one is chosen by the user.   

Figure 45. Data Operations Buttons 

 

Data operations (Figure 45) can be found at the top left of the data display 
section.  These operations include: Export, Export and Delete, Move, Delete, Add 
Tag, Remove Tag, and Clear All Tags.  One additional operation that exists in 
this area of the user interface that does not involve checked data items is the 
Import operation.  

Context menu options (Figure 46) exist for all Plates for checking and unchecking 
all the plate’s scans.  The Check All Scans button allows the user to quickly 
check all scans for the specified plate.  The Uncheck All Scans button allows the 
user to quickly uncheck all scans for the specified plate. 
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Figure 46. Context Menu Options for Plates 

 

Context menu options (Figure 47) exist for all Scans for checking and unchecking 
all of the scan’s scan results.  The Check All Scan Results button allows the user 
to quickly check all scan results for the specified scan. The Uncheck All Scan 
Results button allows the user to quickly uncheck all scan results for the 
specified scan. 

Figure 47. Context Menu Options for Scans 

 

To check all data in the data view 

• With the Data tab selected in the Data Management screen, click the 
Check All button at the top right of the screen (Figure 48). 

Figure 48. Check All Button 

 

To uncheck all data in the data view 

• With the Data tab selected in the Data Management screen, click the 
Uncheck All Button at the top right of the screen (Figure 49). 

Figure 49. Uncheck All Button 

 

To check all scans of a plate in the data view 

1. With the Data tab selected in the Data Management screen, right click 
the plate you want to check all scans for (Figure 46). 

2. Select the Check All Scans menu item in the context menu. 
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To uncheck all scans of a plate in the data view 

1. With the Data tab selected in the Data Management screen, right click 
the plate you want to uncheck all scans for. (Figure 46). 

2. Select the Uncheck All Scans menu item in the context menu. 

To check all scan results of a scan in the data view 

1. With the Data tab selected in the Data Management screen, right click 
the scan you want to check all scan results for (Figure 47). 

2. Select the Check All Scan Results menu item in the context menu. 

To uncheck all scan results of a scan in the data view 

1. With the Data tab selected in the Data Management screen, right click 
the scan you want to uncheck all scan results for (Figure 47). 

2. Select the Uncheck All Scan Results menu item in the context menu. 

7.7 Importing Data 

Figure 50. Import Data Button 

  

The Import button (Figure 50) allows the user to import data into the Celigo 
database.  Celigo data in file format is referred to as archives and archives can 
be imported back into a Celigo database using this operation.   

When you import plates, you are returning plates, scans, and the associated 
scan results from their archive location (the location of the local hard drive) into 
the database in *.rcf format for use. 

To import plates 

1. Locate the files that you want to import. 

2. In the Data tab, click the Import button. 

The Import Plates dialog box appears (Figure 51). 

Figure 51. Import Plates Dialog Box 

 

3. To display the path that contains the folder with the plate folders to import: 
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• To the right of the Root Folder Containing Plates field, click the Browse... 
button and then, in the resulting Select Folder dialog box (Figure 52), 
navigate to the needed folder and click Select Folder. 

NOTE: The default directory for archives will be the following:  
C:\Users\<username>\Documents\Celigo\Archives 

• Users must browse to and select the parent folder that contains the 
entire archive folder. Users should not browse to and select the archive 
folder itself, or else no archives will appear in the list to import. 

Figure 52. Select Folder Dialogue Box 

 

If the selected plate folder contains exported archive folders (which 
individually contain their own .rcf file inside), the list of plate IDs appears in 
the Import Plates window. (The .rcf file must have the same name as the 
archive folder. The archive folder name is the plate name).  If the, Include 
Subfolders checkbox is checked, when the path is updated by the Browse… 
button, the system will check every subfolder of the path for archives. 

On the left side of the Import Plates dialog box, checkmark all plates that you 
want to import (Figure 53).  You can also optionally choose individual scans 
of a plate to import. 

This dialog will also specify whether a plate or its scan already exists in the 
database and provides you with the descriptions of the plates and scans to 
better inform the user what would be imported. 

Figure 53. Plates Check Marked for Import 

 

4. If renaming of the plate that is being imported is desired: 
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• Select the plate row of the plate to be renamed.  

• Right click in the New Name column for the plate row selected.  

• A context menu will appear with a Rename menu item (Figure 54).   

• Click the rename menu item and the field will become editable. 

• Type in a new name for the plate and press enter. 

Figure 54. Renaming Plate During Import 

 

 

NOTE:   If a checkmark is visible in the field Exists in Database, 
the plate ID (for the new name field) already exists in the 
database.  Continuing with an import operation will result in 
either the merging of the plate’s scans with the existing plate in 
the database (if the plate is compatible and no duplicate scans 
exist) or an auto rename of the new plate name. 

5. Click Import. 

The system begins importing the .rcf format files to the database and a 
progress screen appears.  After each plate and scan completes, the progress 
for the item will state 100% and an import message for the item will appear 
for each plate and scan stating what the software did as part of the import 
operation. 

Clicking Abort will cancel the import operation. 

• If importing a plate that doesn’t already exist in the database, the 
software will import the plate with the specified plate name (Figure 55).  
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Figure 55. Importing New Plate 

    

• If importing a plate that already exists, the software will check to see if 
scans and scan results already exist within a plate and will automatically 
pre-select to import compatible scan and scan results. The software will 
then merge the new scans within the existing plate (Figure 56). 

Figure 56. Import Plate Merging 

  

• If importing a plate with scan and scan results that already exists, the 

software will auto rename the imported plate.  The software will 

automatically append to the name of the plate being imported to 

ensure it has a unique name (Figure 57). 



Nexcelom Celigo® Cytometer Administrator Guide Managing Data 

48 of 136 

Figure 57. Import Plate Auto Rename 

 

7.8 Exporting Data 

Figure 58. Export Button Options 

 

The Export button (Figure 58) allows the user to export checked data from the 
Celigo database into a file format referred to as an archive.  The Export and 
Delete button performs the same task as the export operation, but will also delete 
the checked data that was exported after a successful export operation. 

When you export plates, scans, or scan results, you are moving them from the 
SQL database to your local data drive in .rcf format, followed by moving this 
archive copy to a different data drive for possible future use. 

You select plates and scans for exporting with the associated scan results; you 
cannot select only scan results for exporting. You can only export scan results as 
a set; you do not export individual scan results. 

To export plates, scans, or scan results 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 30 above). 

3. In the data view of the Data Tab, check the plates, scans, or scan results that 
you want to export. 

To do this, left-click the checkbox to the left of the plate or select the Check 
All button (Figure 48), as applicable. To uncheck all, select the Uncheck All 
button (Figure 49). 
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NOTE:  If you checkmark a plate, then a checkmark is 
automatically applied to ALL of its scans and all scan 
results, since they cannot exist in the database without 
an associated plate. Likewise, if you checkmark a scan, 
then a checkmark is automatically applied to its 
associated scan results. 

4. Click Export. 

A Browse for Folder dialog box appears (Figure 52). In the dialog box, 
navigate to the desired destination for the file. 

 

NOTE: For best performance, archiving to an eSATA, 
USB 3.0 external hard drive, or networked file location 
over a 1 Gigabit Ethernet connection or better is 
recommended over exporting to the local C drive. 

 

NOTE: Another option exists for exporting and deleting 
data at the same time.  This is meant to streamline the 
operation if a user intends to delete the data after 
exporting.  Data will only be deleted if it was 
successfully exported. 

5. Click Select Folder. 

The system begins exporting the plate in .rcf format and a progress bar 
appears. 

 

NOTE:  At this time, clicking Cancel only cancels the 
action on the next plate (assuming multiple plates were 
selected for export) to be exported and not on the plate 
currently being exported. 

7.9 Moving Data 

Figure 59. Move Button 

 

The Move button (Figure 59) allows the user to move checked data from one 
Celigo folder to another. 

To move data  

1. In the Start tab, in the task screen, click Manage Data. 

The Data Management screen appears (Figure 30 above) with the files and 
folders that the logged-in user has permission to view (by means of the 
Scientist or Local Administrator permission selected when the user profile 
was created). 

2. In the data display of the Data Tab, check all plates, scans, and scan results 
that you want to move to a new folder. 

To do this, left-click the checkbox to the left of the plate or select the Check 
All button (Figure 48), as applicable. To uncheck all, select the Uncheck All 
button Figure 49). 
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NOTE:  If you checkmark a plate, then a checkmark is 
automatically applied to ALL of its scans and all scan 
results, since they cannot exist in the database without 
an associated plate. Likewise, if you checkmark a scan, 
then a checkmark is automatically applied to its 
associated scan results. 

3. Click the move button and the Folder Selection dialog will appear (Figure 60). 

4. Select the folder to move all the checked data to and click OK. 

Figure 60. Move Data – Folder Selection Dialog 

 

5. After the OK button is pressed, the software will attempt to perform the move 
operation for all data that is checked.  If one of the following conditions for 
the data is found, no operation will be performed: 

• The data already resides in the selected folder. 

• The data is currently locked (the data is in use by another user). A lock 
icon will appear next to the data and no operation is performed. 

• The user does not have permission to move the data. 

7.10 Deleting Data 

Figure 61. Delete Button 

 

The Delete button (Figure 61) allows the user to delete checked data from the 
Celigo database. 

To delete plates, scans, or scan results 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 30 above). 

3. Search as needed to find the items you want to delete (section Figure 32). 

4. In the right-hand pane check the data items that you want to delete. 

To do this, left-click the checkbox to the left of the plate or select the Check 
All button (Figure 48), as applicable. To uncheck all, select the Uncheck All 
button (Figure 49). 
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NOTE:  If you checkmark a plate, then a checkmark is 
automatically applied to ALL of its scans and all scan 
results, since they cannot exist in the database without 
an associated plate. Likewise, if you checkmark a scan, 
then a checkmark is automatically applied to its 
associated scan results. 

5. At the top of the data display in the Data Tab, click Delete (Figure 61). 

The system deletes all check marked items from the database (the entire 
plate and its associated scans and scan results). 

6. Do one of the following: 

• If you want to wait for the system to begin freeing up space from the 
deleted files at its next scheduled checkpoint, no additional action is 
required. 

• If you want to immediately request that the system begin freeing up 
space from the deleted files, click the Recover Free Space button at the 
bottom right of the Data Management window (Figure 62). 

Note:  The Recover Free Space button is only active for the 
Sysadmin user.  

Figure 62. Recover Free Space Button 

 

 

NOTE:   Recover Free Space requires a Celigo 
installation utilizing SQL Server 2012 or newer for the 
Celigo database and requires Local Administrator 
permissions.  Please be aware that the Recover Free 
Space operation is resource intensive and should not 
be performed with ongoing Celigo activities 
(particularly if working with a Celigo Network Database 
setup).  Be sure to run this during times of low activity. 

7.11 Tagging Data 

Figure 63. Add Tag Button 

 

The Add Tag button (Figure 63) allows the user to add a tag to checked data.  
When first clicking on the Add Tag button, a dialog will appear asking the user to 
type in a new tag.  As the user types a tag, a list will appear of tags matching the 
text typed if any exist.  Once the tag has been entered, the user clicks OK to 
complete the operation and then a tag will appear next to the checked items. 



Nexcelom Celigo® Cytometer Administrator Guide Managing Data 

52 of 136 

Figure 64. Add Tag Selection Dialogs 

    

To tag data  

1. In the Start tab, in the task screen, click Manage Data. 

The Data Management screen appears (Figure 30 above) with the files and 
folders that the logged-in user has permission to view (by means of the 
Scientist or Local Administrator permission selected when the user profile 
was created). 

2. In the data display of the Data Tab, check all plates, scans, and scan results 
that you want to associate a tag with. 

To do this, left-click the checkbox to the left of the plate or select the Check 
All button (Figure 48), as applicable. To uncheck all, select the Uncheck All 
button (Figure 49). 

 

NOTE:  For adding or removing specific tags to/from 
data, operations are only performed on top most 
checked data.  For example, if a plate is checked, 
adding or removing a specific tag is only performed on 
the plate, but not the plate’s scans or scan results.  If a 
scan is checked, adding or removing a specific tag is 
only performed on the scan, but the not scan’s scan 
results.  

3. Click the Add Tag button (Figure 63) and the Tag Selection dialog (Figure 
64) will appear. 

4. In the Tag Selection dialog, enter a new or existing tag to associate with all 
the checked data to and click OK. 

As text is typed, all matching tags will be displayed in a dropdown. 

5. After the OK button is pressed, the tag is associated with all top most 
checked items. 

7.12 Removing a Tag from Data 

Figure 65. Delete Tag Button 

 

The Delete Tag button (Figure 65) allows the user to delete a tag from checked 
data.  When first clicking on the Delete Tag button, a dialog will appear (Figure 
66) asking the user to type in a tag to remove.  As the user types a tag, a list will 
appear of tags matching the text typed if any exist.  If a tag is typed that is 
associated with the checked data, that tag will be removed when the user clicks 
OK.  If a tag is typed that is not associated with the checked data, the data’s tags 
will remain unchanged. 
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Figure 66. Delete Tag Selection Dialogs 

    

Figure 67. Clear All Tags Button 

 

The Clear All Tags button (Figure 67) allows the user to delete all tags from 
checked data. 

To remove a specific tag from data  

1. In the Start tab, in the task screen, click Manage Data. 

The Data Management screen appears (Figure 30 above) with the files and 
folders that the logged-in user has permission to view (by means of the 
Scientist or Local Administrator permission selected when the user profile 
was created). 

2. In the data view of the Data Tab, check all plates, scans, and scan results 
that you want to dissociate a tag from. 

To do this, left-click the checkbox to the left of the plate or select the Check 
All button (Figure 48), as applicable. To uncheck all, select the Uncheck All 
button (Figure 49). 

 

NOTE:  For adding or removing specific tags to/from 
data, operations are only performed on top most 
checked data.  For example, if a plate is checked, 
adding or removing a specific tag is only performed on 
the plate, but not the plate’s scans or scan results.  If a 
scan is checked, adding or removing a specific tag is 
only performed on the scan, but the not scan’s scan 
results.  

3. Click the Remove Tag button and the Tag Selection dialog will appear. 

4. In the Tag Selection dialog, enter an existing tag to dissociate from the 
checked data to and click OK. 

As text is typed, all matching tags will be displayed in dropdown. 

5. After the OK button is pressed, the tag, if it is found associated with the top 
most checked items, is removed from the data item. 

To remove all tags from data  

1. In the Start tab, in the task screen, click Manage Data. 

The Data Management screen appears (Figure 30 above) with the files and 
folders that the logged-in user has permission to view (by means of the 
Scientist or Local Administrator permission selected when the user profile 
was created). 

2. In the data view of the Data Tab, check all plates, scans, and scan results 
that you want to clear all tags from. 
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To do this, left-click the checkbox to the left of the plate or select the Check 
All button (Figure 48), as applicable. To uncheck all, select the Uncheck All 
button (Figure 49). 

 

NOTE:  If you checkmark a plate, then a checkmark is 
automatically applied to ALL of its scans and all scan 
results, since they cannot exist in the database without 
an associated plate. Likewise, if you checkmark a scan, 
then a checkmark is automatically applied to its 
associated scan results. 

3. Click the Delete All Tags button. 

4. After the button is pressed, all tags are removed from all plates, scans, and 
scan results currently checked. 

7.13 Renaming a Plate 

The user can right click on any plate in the displayed area and additional 
operations for the plate will appear via a context menu.   

Figure 68. Plate Context Menu for Renaming a Plate 

 

The Rename button allows the user to rename a plate by displaying the plate 
name in an editable textbox.  If the name is already taken or if the name is 
invalid, the editing box for the name will appear red. 

Figure 69. Editing Plate Name 

 

To change a Plate Name (Plate ID) 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 30 above). 

3. In the Data Management screen, click the Plate name that you want to 
change. 

4. Right Click on the Plate. 

A context menu (Figure 68) will appear with an option to rename the plate.  
After selecting this, the Plate name appears in a recessed field for editing. 

5. Type the new name. 
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6. Press the enter key or click anywhere off of the new name to commit it. 

7.14 Modifying Data Descriptions 

The user can right click on any plate, scan, or scan result in the displayed area 
and an option to modify the data item’s description will appear via a context 
menu.  Clicking the Modify Description button allows the user to modify the data 
item’s description by displaying the existing description in an editable textbox. 

Figure 70. Data Description 

 

 

To change a Plate Description 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 30 above). 

3. In the Data Management screen, click the Plate name that you want to 
change. 

4. Right click on the Plate. 

A context menu (Figure 68) will appear with an option to modify the plate’s 
description. After selecting this, the Plate description appears in a recessed 
field for editing. 

5. Type the new description. 

6. Press the enter key or click anywhere off of the new description to commit it. 

To change a Scan Description 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 30 above). 

3. In the Data Management screen, expand the Plate containing the scan you 
want to update. 

4. Right Click on the Scan. 
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A context menu will appear with an option to modify the scan’s description. 
After selecting this, the Scan description appears in a recessed field for 
editing. 

5. Type the new description. 

6. Press the enter key or click anywhere off of the new description to commit it. 

To change a Scan Result Description 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 30 above). 

3. In the Data Management screen, expand the Plate and Scan containing the 
scan result you want to update. 

4. Right click on the Scan Result. 

A context menu will appear with an option to modify the scan result’s 
description. After selecting this, the Scan Result description appears in a 
recessed field for editing. 

5. Type the new description. 

6. Press the enter key or click anywhere off of the new description to commit it. 

7.15 Loading a Scan 

The user can right click on any scan in the displayed area and an option will 
appear via a context menu to load the scan (Figure 71).  The Analyze Scan 
button allows the user to load the selected scan directly into the Analyze tab. 

Figure 71. Context Menu for Scans 

 

The user can right click on any scan result in the displayed area and an option 
will appear via a context menu (Figure 72) to load the scan with the specified 
scan result. View Result button allows the user to load the scan with the specified 
scan result directly into the Results tab. 

Figure 72. Context Menu for Scan Results 

 

To Load a Scan 

1. Log in to the Celigo application. 



Nexcelom Celigo® Cytometer Administrator Guide Managing Data 

57 of 136 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 30 above). 

3. In the Data Management screen, expand the Plate you want to load a 
scan from. 

4. Right Click on the scan you want to load. 

A context menu (Figure 71) will appear with an option to load the scan.  

5. Select the Analyze Scan menu item from the context menu and the scan will 
load directly into the Analyze tab. 

To Load a Scan with a specific Scan Result 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 30 above). 

3. In the Data Management screen, expand the Plate and Scan you want to 
load a scan from. 

4. Right Click on the scan result you want have loaded with the Scan. 

A context menu (Figure 72) will appear with an option to load the scan with 
the specified scan result.  

5. Select the View Result menu item from the context menu and the scan will 
load with the specified scan result directly into the Results tab. 

7.16 Deleting Scan Images 

The Delete Images button allows the user to delete all images associated with 
the scan while keeping the scan data in the Celigo database.  If the user selects 
this operation, the user will first be prompted to confirm the operation.  Once the 
user confirms the operation, the scan’s images will be deleted.   

Figure 73. Image Deletion Confirmation 

 

Once the images are deleted for a scan, the scan will have the text Deleted 
displayed in its Image Format column and will no longer be capable of being re-
analyzed (read-only).  If the scan is loaded, the user will only have access to the 
Results Tab displaying the well thumbnails and measurements.  Since no images 
are available for the scan, well viewing is disabled for the scan. 

To Delete Scan Images 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 
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The Data Management screen appears (Figure 30 above). 

3. In the Data Management screen, expand the Plate you want to delete scan 
images from. 

4. Right Click on the scan you want to delete images from. 

A context menu will appear with an option to delete scan images.  

5. Select the Delete Images menu item from the context menu to have its 
images deleted. 

6. Click Yes for the confirmation pop-up (Figure 73) and the scan’s images will 
be deleted. 
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8. Managing Projects 

Figure 74. Data Management Screen 

 

The Data Management is broken into five separate views: Data, Projects, 
Settings, Report Templates and Summary.  The Projects Tab displays all the 
project files, currently stored in the Celigo database, which the logged in user has 
access to.  Projects refer to a collection of settings that bundle the plate profile, 
experiment, and export settings together.  Projects are displayed to the user in a 
grid on the right-hand side of the screen. 

Figure 75. Projects Tab in Data Management 

 

8.1 Searching for Projects 

The default setting for this Projects Tab (Figure 75) is to display all the projects 
the user has access to.  If the user would like to limit what is displayed, the user 
can modify the filter settings found on the left side of the screen (Figure 76). 



Nexcelom Celigo® Cytometer Administrator Guide Managing Projects 

60 of 136 

Figure 76. Search Filters for Projects 

  

Filters are broken up into 3 sections:  Search, Folders, and Project Filters.   

Search 

The Search section appears just above the Folders section.  This section is 
primarily an open text field that allows the user to type in any text to match a 
name, description, or tag for any project.  If desired, a checkbox exists to limit the 
search to only the project’s related tags. 

Folders 

The Folders section appears underneath the Search section and displays all 
folders the user has access to.   

Project Filters 

The Project Filters section appears just below the Folders section.  This section 
allows a user to filter projects by setting plate profile, application, project creator, 
date the project was created, and date the project was last modified. 

 

 

 

Search Section 

Folders Section 

Project Filters Section 
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Refreshing Controls 

If a user modifies any setting while the Auto Refresh checkbox (Figure 77) is 
checked, a refresh operation will occur, and the software will display the updated 
project set matching the new filter criteria on the right-hand side of the screen. 

Figure 77. Auto Refresh Checkbox 

 

If the Auto Refresh checkbox is not checked, no refresh operation will occur until 
the user clicks the Refresh button (Figure 78) located at the bottom right hand 
side of the screen. 

Figure 78. Refresh Button 

 

Perform the following steps to search for projects.  

1. Log into the Celigo application.  

2. In the Start tab’s task screen, click Manage Data. The Data Management 
screen appears. 

3. Select the Projects Tab. 

4. Make adjustments to any search and filter entries as applicable (see 
descriptions above). 

5. Click Refresh. The Data display on the right side of the screen will display 
any found project results matching the search parameters/filters specified. 

 

NOTE:  If the Auto Refresh checkbox is checked, step 5 
above is not necessary.  A refresh operation will be 
invoked for every change setting as a setting is 
changed. 

8.2 Clearing Search Selections 

The Reset Filters button (Figure 79) provides the user the ability to revert all the 
filters back to default settings which will display all projects on the right-hand side 
of the screen after a refresh is invoked. 

Figure 79. Reset Filters Button 

 

To clear search settings for projects  

• In Data Management screen in the Projects Tab, click the Reset Filters 
button (Figure 79). 

8.3 Updating Search Selections 

The Project Filters are set to have their selectable options and limits based on 
the entire database.  Application will therefore only display applications that are 
associated with the projects in the database.  Created By filter and all other filters 
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function similarly.  When the Celigo is connected to a network database (where it 
is possible for other users to be changing the data in the database you are 
connected to) the limits of your filters can change from when they have been 
loaded.  The Refresh Filters button (Figure 80) allows a user to refresh the limits 
of all their filters to the current state of the database.   

Figure 80. Refresh Filters Button 

 

 

NOTE:  The Refresh Filters button is only displayed 
when the Celigo is connected to a network database.  
This option is not present for Celigos connected to 
local databases. 

To update the bounds of the search settings for projects  

• In Data Management screen in the Projects Tab, click the Refresh Filters 
button. 

8.4 Viewing Projects 

Projects are displayed to the user in a grid (Figure 81) on the right-hand side of 
the screen. This section of the screen allows the user to view projects matching 
the filters specified and enables the user to perform various functions on 
that data. 

Figure 81. Data Display Grid for Projects 

 

The projects displayed in the grid are organized into columns that display various 
properties of the projects.  These columns include:  Check, Icon, Name, Folder, 
Application, Created By, Created Data, Last Modified, Description, and Tags.  All 
columns other than Tags are sortable.  The button strip (Figure 82) at the bottom 
of the projects display section displays the project count of the found matching 
settings set.   
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Figure 82. Button Strip for Projects 

 

8.5 Exporting Projects Report 

The Projects Tab allows a user to copy the current data result set as an image, 
text, or as an exported CSV file. 

Figure 83. Copy Button Dropdown Menu 

 

The Copy As Image button allows the user to copy the displayed projects (as 
seen on the screen) as an image to the clipboard. 

The Copy As Text button allows the user to copy all projects as text to the 
clipboard. 

Figure 84. Export Button 

 

The Export button (Figure 84) allows the user to save a text file of all projects 
to disk. 

8.6 Selecting Projects 

Each project item can be checked or unchecked.  Checking a project item marks 
it to be included for a project operation if one is chosen by the user.   

Figure 85. Project Operation Buttons 

 

Project operations (Figure 85) can be found at the top left of the projects display 
section.  These operations include: Import, Export, Export and Delete, Create 
New, Edit, Move, Delete, Add Tag, Remove Tag, and Clear All Tags.   

To check all projects in the projects view 

• With the Project tab selected in the Data Management screen, click the 
Check All button at the top right of the screen (Figure 86). 

Figure 86. Check All Button 

 

To uncheck all projects in the projects view 

• With the Projects tab selected in the Data Management screen, click the 
Uncheck All Button at the top right of the screen (Figure 87). 
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Figure 87. Uncheck All Button 

 

8.7 Importing Projects 

Figure 88. Import Button 

  

The Import button (Figure 88) allows the user to import projects into the Celigo 
database.  When you import projects, you are importing to the database in XML 
format.  

To import projects 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 101). 

3. Click the Projects Tab. 

4. Click Import. 

A Select Projects to Import dialog box appears. The dialog box for importing 
projects is shown in (Figure 89). 

NOTE: The default directory for settings will be the following:  
C:\Users\<username>\Documents\Celigo\Projects 

Figure 89. Importing Projects Dialog Box 

 

5. In the Look in field, navigate to the folder that contains the projects to import. 

The system displays the projects folders that contain a corresponding XML 
file. The file extensions for the XML files are as follows: 

• Projects: .cpj (Celigo Project). 

6. Do one of the following to select the project(s) that you want to import: 

• To select a single file: In the File name field, type a name for the project 
that you want to import. 

• To select multiple files, Ctrl+click. 
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7. Click Open. 

The system begins the import operation and a progress screen appears. 

The system imports the .cpj files (XML format) to the database. 

Clicking Cancel will cancel the import operation. 

8.8 Exporting Projects 

Figure 90. Export Button 

 

The Export button (Figure 90) allows the user to export checked projects from the 
Celigo database into a file format.  The Export and Delete button performs the 
same task as the export operation, but also will delete the checked projects that 
were exported after the export operation is successful. 

To export projects 

1. Log into the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 101). 

3. Select the Projects Tab. 

4. In the right pane, check the projects you want to export. 

5. Click Export. 

Figure 92 shows the dialog box that appears for exporting the Project 
line item.  

6. Navigate to designated or default folder (Figure 91), if applicable. 

7. Enter File name. 

8. Click Save. 

Figure 91. Exporting Project  
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Figure 92. Exporting Projects Dialog  

 

NOTE: The default directory for settings will be the following:  
C:\Users\<username>\Documents\Celigo\Projects 

• Projects: .cpj (Celigo Project). 

8.9 Moving Projects 

Figure 93. Move Button 

 

The Move button (Figure 93) allows the user to move checked projects from one 
Celigo folder to another. 

To move projects  

1. In the Start tab, in the task screen, click Manage Data. 

The Data Management screen appears (Figure 101) with the files and folders 
that the logged-in user has permission to view (by means of the Scientist or 
Local Administrator permission selected when the user profile was created). 

2. In the data view of the Projects Tab, check all projects that you want to move 
to a new folder. 

To do this, left-click the checkbox to the left of the project or select the Check 
All button (Figure 113), as applicable. To uncheck all, select the Uncheck 
All button (Figure 114). 

3. Click the Move button and the Folder Selection dialog will appear. 

4. In the Folder Selection dialog (Figure 120), select the folder to move all the 
checked projects to and click OK. 

Figure 94. Folder Selection Dialog 

 

5. After the OK button is pressed, the software will attempt to perform the move 
operation for all projects that are checked.  If one of the following conditions 
for the settings is found, no operation will be performed: 
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• The project already resides in the selected folder. 

• The user does not have permission to move the project. 

8.10 Deleting Projects 

Figure 95. Delete Button 

 

The Delete button (Figure 121) allows the user to delete checked projects from 
the Celigo database. 

To delete projects 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above). 

3. Select the Projects Tab. 

4. Search as needed to find the items you want to delete (section 9.1). 

5. In the right-hand pane check the detail items that you want to delete. 

To do this, left-click the checkbox to the left of the project or select the Check 
All button (Figure 113), as applicable. To uncheck all, select the Uncheck 
All button (Figure 114). 

6. At the top of the projects view in the Projects Tab, click Delete. 

The system deletes all check marked items from the database. 

8.11 Tagging Projects 

Figure 96. Add Tag Button 

 

The Add Tag button (Figure 96) allows the user to add a tag to checked projects.  
When first clicking on the Add Tag button, a dialog will appear asking the user to 
type in a new tag.  As the user types a tag, a list will appear of tags matching the 
text typed if any exist.  Once the tag has been entered, the user clicks OK to 
complete the operation and then a tag will appear next to the checked items. 

Figure 97. Add Tag Selection Dialogs 
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To tag projects  

1. In the Start tab, in the task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above) with the files and 
folders that the logged-in user has permission to view (by means of the 
Scientist or Local Administrator permission selected when the user profile 
was created). 

2. In the projects view of the Projects Tab, check all projects that you want to 
associate a tag with. 

To do this, left-click the checkbox to the left of the project or select the Check 
All button (Figure 113), as applicable. To uncheck all, select the Uncheck 
All button (Figure 114). 

3. Click the Add Tag button (Figure 96) and the Tag Selection dialog (Figure 
97) will appear. 

4. In the Tag Selection dialog, enter a new or existing tag to associate with all 
the checked projects to and click OK. 

As text is typed, all matching tags will be displayed in dropdown. 

5. After the OK button is pressed, the tag is associated with all checked items. 

8.12 Removing a Tag from Projects 

Figure 98. Delete Tag Button 

 

The Delete Tag button (Figure 98) allows the user to delete a tag from checked 
projects.  When first clicking on the Delete Tag button, a dialog will appear 
(Figure 99) asking the user to type in a tag to remove.  As the user types a tag, a 
list will appear of tags matching the text typed if any exist.  If a tag is typed that is 
associated with the checked projects, that tag will be removed when the user 
clicks OK.  If a tag is typed that is not associated with the checked projects, the 
data’s tags will remain unchanged. 
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Figure 99. Delete Tag Selection Dialog 

 

Figure 100. Delete All Tags Button 

 

The Delete All Tags button (Figure 100) allows the user to delete all tags from 
checked projects.  

To remove a specific tag from projects  

1. In the Start tab, in the task screen, click Manage Data. 

The Data Management screen appears (Figure 101) with the files and folders 
that the logged-in user has permission to view (by means of the Scientist or 
Local Administrator permission selected when the user profile was created). 

2. In the project view of the Projects Tab, check all projects that you want to 
dissociate a tag from. 

To do this, left-click the checkbox to the left of the project or select the Check 
All button (Figure 113), as applicable. To uncheck all, select the Uncheck 
All button (Figure 114). 

3. Click the Delete Tag button (Figure 99) and the Tag Selection dialog will 
appear. 

4. In the Tag Selection dialog, enter an existing tag to dissociate from the 
checked projects to and click OK. 

As text is typed, all matching tags will be displayed in dropdown. 

5. After the OK button is pressed, the tag, if it is found associated with the 
checked items, is removed from the item. 

To remove all tags from projects  

1. In the Start tab, in the task screen, click Manage Data. 

The Data Management screen appears (Figure 101) with the files and folders 
that the logged-in user has permission to view (by means of the Scientist or 
Local Administrator permission selected when the user profile was created). 
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2. In the projects view of the Projects Tab, check all projects that you want to 
clear all tags from. 

To do this, left-click the checkbox to the left of the project or select the Check 
All button (Figure 113), as applicable. To uncheck all, select the Uncheck 
All button (Figure 114). 

3. Click the Delete All Tags (Figure 100) button. 

4. After the button is pressed, all tags are removed from all projects currently 
checked. 
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9. Managing Settings 

Figure 101. Data Management Screen:  Settings Tab 

 

The Data Management is broken into five separate views: Data, Projects, 
Settings, Report Templates and Summary.  The Settings Tab displays all the 
settings, currently stored in the Celigo database, which the logged in user has 
access to.  Settings refer to Experiments, Analysis Settings, and Classification 
Settings.  Settings are displayed to the user in a grid on the right-hand side of the 
screen. 

Figure 102. Settings Tab in Data Management 

 

9.1 Searching for Settings 

The default setting for this Settings Tab (Figure 102) is to display all the settings 
the user has access to.  If the user would like to limit what is displayed, the user 
can modify the filter settings found on the left side of the screen (Figure 103). 
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Figure 103. Search Filters for Settings 

 

Filters are broken up into 3 sections:  Search, Folders, and Setting Filters.   

Search 

The Search section appears just above the Folders section.  This section is 
primarily an open text field that allows the user to type in any text to match a 
name, description, or tag for any setting (experiment, analysis settings, or 
classification settings).  If desired, a checkbox exists to limit the search to only 
the setting’s related tags. 

Folders 

The Folders section appears underneath the Search section and displays all 
folders the user has access to.  This section works in the same manner as it 
does in the Settings Tab. 

Setting Filters 

The Setting Filters section appears just below the Folders section.  This section 
allows a user to filter settings by setting type, application, setting creator, date the 
setting was created, and date the setting was last modified. 

 

 

 

Search Section 

Folders Section 

Setting Filters Section 
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Refreshing Controls 

If a user modifies any setting while the Auto Refresh checkbox (Figure 104) is 
checked, a refresh operation will occur and the software will display the updated 
settings set matching the new filter criteria on the right-hand side of the screen. 

Figure 104. Auto Refresh Checkbox 

 

If the Auto Refresh checkbox is not checked, no refresh operation will occur until 
the user clicks the Refresh button (Figure 105) located at the bottom right hand 
side of the screen. 

Figure 105. Refresh Button 

 

Perform the following steps to search for settings.  

To search for settings (experiments, analysis settings, classification 
settings): 

1. Log into the Celigo application.  

2. In the Start tab’s task screen, click Manage Data. The Data Management 
screen appears. 

3. Select the Settings Tab. 

4. Make adjustments to any search and filter entries as applicable (see 
descriptions above). 

5. Click Refresh. The Data display on the right side of the screen will display 
any found setting results matching the search parameters/filters specified. 

 

NOTE:  If the Auto Refresh checkbox is checked, step 5 
above is not necessary.  A refresh operation will be 
invoked for every change setting as a setting is 
changed. 

9.2 Clearing Search Selections 

The Reset Filters button (Figure 106) provides the user the ability to revert all the 
filters back to default settings which will display all settings on the right-hand side 
of the screen after a refresh is invoked. 

Figure 106. Reset Filters Button 

 

To clear search settings for settings (experiments, analysis settings, classification 
settings): 

• In Data Management screen in the Settings Tab, click the Reset Filters 
button (Figure 106) Updating Search Selections. 

The Setting Filters are set to have their selectable options and limits based on 
the entire database.  Application will therefore only display applications that are 
associated with the settings in the database.  Created By filter and all other filters 
function similarly.  When the Celigo is connected to a network database (where it 
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is possible for other users to be changing the data in the database you are 
connected to) the limits of your filters can change from when they have been 
loaded.  The Refresh Filters button (Figure 107) allows a user to refresh the limits 
of all their filters to the current state of the database.   

Figure 107. Refresh Filters Button 

 

 

NOTE:  The Refresh Filters button is only displayed 
when the Celigo is connected to a network database.  
This option is not present for Celigos connected to 
local databases. 

To update the bounds of the search settings for settings (experiments, analysis 
settings, classification settings):  

• In Data Management screen in the Settings Tab, click the Refresh Filters 
button. 

9.3 Viewing Settings 

Settings are displayed to the user in a grid (Figure 108) on the right-hand side of 
the screen. This section of the screen allows the user to view settings matching 
the filters specified and enables the user to perform various functions on that data. 

Figure 108. Data Display Grid for Settings 

 

The settings displayed in the grid are organized into columns that display various 
properties of the settings.  These columns include:  Check, Type, Name, Folder, 
Application, Created By, Created Data, Last Modified, Description, and Tags.  All 
columns other than Tags are sortable.  The button strip (Figure 109) at the 
bottom of the settings display section displays the setting count of the found 
matching settings set.   

Figure 109. Button Strip for Settings 
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9.4 Exporting Settings Report 

The Settings Tab allows a user to copy the current data result set as an image, 
text, or as an exported CSV file (Figure 110). 

Figure 110. Copy Button 

 

The Copy As Image button allows the user to copy the displayed settings (as 
seen on the screen) as an image to the clipboard. 

The Copy As Text button allows the user to copy all settings as text to the 
clipboard. 

Figure 111. Export Button 

 

The Export button (Figure 111) allows the user to save a text file of all settings to 
disk. 

9.5 Selecting Settings 

Each setting item (experiment, analysis setting, and classification setting) can be 
checked or unchecked.  Checking a data item marks the data item to be included 
for a data operation if one is chosen by the user.   

Figure 112. Setting Operation Buttons 

 

Setting operations (Figure 112) can be found at the top left of the setting display 
section.  These operations include: Export, Export and Delete, Move, Delete, Add 
Tag, Remove Tag, and Clear All Tags.  One additional operation that exists in 
this area of the user interface that does not involve checked data items is the 
Import operation.  

To check all settings in the settings view 

• With the Setting tab selected in the Data Management screen, click the 
Check All button at the top right of the screen (Figure 113). 

Figure 113. Check All Button 

 

To uncheck all settings in the settings view 

• With the Setting tab selected in the Data Management screen, click the 
Uncheck All Button at the top right of the screen (Figure 114). 

Figure 114. Uncheck All Button 
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9.6 Importing Settings 

Figure 115. Import Button 

  

The Import button (Figure 115) allows the user to import settings into the Celigo 
database.  When you import settings, you are importing to the database in XML 
format.  

To import settings 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above). 

3. Click the Settings Tab. 

4. Click Import. 

A Select Settings to Import dialog box appears. The dialog box for importing 
settings is shown in (Figure 116). 

NOTE: The default directory for settings will be the following:  
C:\Users\<username>\Documents\Celigo\Settings 

Figure 116. Importing Settings Dialog Box 

 

5. In the Look in field, navigate to the folder that contains the settings to import. 

The system displays the settings folders that contain a corresponding XML 
file. The file extensions for the XML files are as follows: 

• Analysis Settings: .cas (Celigo Analysis Setting). 

• Classification Settings: .ccs (Celigo Classification Setting). 

• Experiments: .ces (Celigo Experiment Setting). 

6. Do one of the following to select the setting(s) that you want to import: 

• To select a single file: In the File name field, type a name for the 
experiment that you want to import. 

• To select multiple files, Ctrl+click. 

7. Click Open. 

The system begins the import operation and a progress screen appears. 

The system imports the .cas, .ccs, or .ces files (XML format) to the database. 

Clicking Cancel will cancel the import operation. 
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9.7 Exporting Settings 

Figure 117. Export Button 

 

The Export button (Figure 117) allows the user to export checked settings from 
the Celigo database into a file format.  The Export and Delete button performs 
the same task as the export operation, but also will delete the checked settings 
that were exported after the export operation is successful. 

To export settings 

1. Log into the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above). 

3. Select the Settings Tab. 

4. Check the settings you want to export, in the right pane. 

5. Click Export. 

6. Navigate to designated or default folder (Figure 118), if applicable 

7. Enter File name 

8. Click Save 

Figure 118. Exporting Dialog for Setting 

 

NOTE: The default directory for settings will be the following:  
C:\Users\<username>\Documents\Celigo\Settings 

• Analysis Settings: .cas (Celigo Analysis Setting) 

• Classification Settings: .ccs (Celigo Classification Setting) 

• Experiments: .ces (Celigo Experiment Setting) 



Nexcelom Celigo® Cytometer Administrator Guide Managing Settings 

78 of 136 

9.8 Moving Settings 

Figure 119. Move Button 

 

The Move button (Figure 119) allows the user to move checked settings from one 
Celigo folder to another.  

To move settings:  

1. In the Start tab, in the task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above) with the files and 
folders that the logged-in user has permission to view (by means of the 
Scientist or Local Administrator permission selected when the user profile 
was created). 

2. In the data view of the Setting Tab, check all settings that you want to move 
to a new folder. 

To do this, left-click the checkbox to the left of the setting or select the Check 
All button (Figure 113), as applicable. To uncheck all, select the Uncheck 
All button (Figure 114). 

3. Click the Move button and the Folder Selection dialog will appear. 

4. In the Folder Selection dialog (Figure 120), select the folder to move all the 
checked settings to and click OK. 

Figure 120. Folder Selection Dialog 

 

5. After the OK button is pressed, the software will attempt to perform the move 
operation for all settings that are checked.  If one of the following conditions 
for the settings is found, no operation will be performed: 

• The setting already resides in the selected folder. 

• The user does not have permission to move the setting. 

9.9 Deleting Settings 

Figure 121. Delete Button 

 

The Delete button (Figure 121) allows the user to delete checked settings from 
the Celigo database. 

To delete experiments, analysis settings, classification settings 

1. Log in to the Celigo application. 
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2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above). 

3. Select the Settings Tab. 

4. Search as needed to find the items you want to delete (section 9.1). 

5. In the right-hand pane check the detail items that you want to delete. 

To do this, left-click the checkbox to the left of the setting or select the Check 
All button (Figure 113), as applicable. To uncheck all, select the Uncheck 
All button (Figure 114). 

6. At the top of the settings view in the Settings Tab, click Delete. 

The system deletes all check marked items from the database. 

9.10 Tagging Settings 

Figure 122. Add Tag Button 

 

The Add Tag button (Figure 122) allows the user to add a tag to checked 
settings.  When first clicking on the Add Tag button, a dialog will appear asking 
the user to type in a new tag.  As the user types a tag, a list will appear of tags 
matching the text typed if any exist.  Once the tag has been entered, the user 
clicks OK to complete the operation and then a tag will appear next to the 
checked items. 

Figure 123. Add Tag Selection Dialogs 

    

 

 

To tag settings  

1. In the Start tab, in the task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above) with the files and 
folders that the logged-in user has permission to view (by means of the 
Scientist or Local Administrator permission selected when the user profile 
was created). 

2. In the settings view of the Settings Tab, check all settings that you want to 
associate a tag with. 
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To do this, left-click the checkbox to the left of the setting or select the Check 
All button (Figure 113), as applicable. To uncheck all, select the Uncheck 
All button (Figure 114). 

3. Click the Add Tag button (Figure 122) and the Tag Selection dialog (Figure 
123) will appear. 

4. In the Tag Selection dialog, enter a new or existing tag to associate with all 
the checked settings to and click OK. 

As text is typed, all matching tags will be displayed in dropdown. 

5. After the OK button is pressed, the tag is associated with all checked items. 

9.11 Removing a Tag from Settings 

Figure 124. Delete Tag Button 

 

The Delete Tag button (Figure 124) allows the user to delete a tag from checked 
settings.  When first clicking on the Delete Tag button, a dialog will appear 
(Figure 125) asking the user to type in a tag to remove.  As the user types a tag, 
a list will appear of tags matching the text typed if any exist.  If a tag is typed that 
is associated with the checked settings, that tag will be removed when the user 
clicks OK.  If a tag is typed that is not associated with the checked settings, the 
data’s tags will remain unchanged. 

Figure 125. Delete Tag Selection Dialog 

    

 

Figure 126. Delete All Tags Button 

 

The Delete All Tags button (Figure 126) allows the user to delete all tags from 
checked settings. 

To remove a specific tag from settings  

1. In the Start tab, in the task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above) with the files and 
folders that the logged-in user has permission to view (by means of the 
Scientist or Local Administrator permission selected when the user profile 
was created). 

2. In the data view of the Settings Tab, check all settings that you want to 
dissociate a tag from. 
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To do this, left-click the checkbox to the left of the setting or select the Check 
All button (Figure 113), as applicable. To uncheck all, select the Uncheck 
All button (Figure 114). 

3. Click the Delete Tag button (Figure 124) and the Tag Selection dialog will 
appear. 

4. In the Tag Selection dialog, enter an existing tag to dissociate from the 
checked settings to and click OK. 

As text is typed, all matching tags will be displayed in dropdown. 

5. After the OK button is pressed, the tag, if it is found associated with the 
checked items, is removed from the item. 

To remove all tags from settings  

1. In the Start tab, in the task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above) with the files and 
folders that the logged-in user has permission to view (by means of the 
Scientist or Local Administrator permission selected when the user profile 
was created). 

2. In the settings view of the Settings Tab, check all settings that you want to 
clear all tags from. 

To do this, left-click the checkbox to the left of the setting or select the Check 
All button (Figure 113), as applicable. To uncheck all, select the Uncheck 
All button (Figure 114). 

3. Click the Delete All Tags (Figure 126) button. 

4. After the button is pressed, all tags are removed from all settings currently 
checked. 

9.12 Updating Settings 

The user can perform text modification operations on settings in the displayed 
area.  These operations include renaming a setting and modifying a setting’s 
description.  Both modifications can occur by double clicking the cell in the 
display grid for the specific setting. 

Figure 127. Editing Setting Name 

 

To change a Setting Name 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above). 

3. In the Data Management screen in the Settings Tab, double-click the Setting 
name that you want to change. 

4. Type the new name. Press the enter key or click anywhere off of the new 
name to commit it (Figure 127). 
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To change a Setting Description 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above). 

3. In the Data Management screen in the Settings Tab, double-click the Setting 
description that you want to change. 

4. Type the new description. 

5. Press the enter key or click anywhere off of the new description to commit it. 
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10. Managing Report Templates 

Figure 128. Data Management Report Template Screen 

 

The Data Management is broken into five separate views: Data, Projects, 
Settings, Report Templates and Summary.  The Report Templates Tab displays 
all the report template files, currently stored in the Celigo database, which the 
logged in user has access to.  Report templates are displayed to the user in a 
grid on the right-hand side of the screen. 

Figure 129. Report Template Tab in Data Management 

 

10.1 Searching for Report Templates 

The default setting for this Report Templates Tab (Figure 129) is to display all the 
report templates the user has access to.  If the user would like to limit what is 
displayed, the user can modify the filter settings found on the left side of the 
screen (Figure 130). 
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Figure 130. Search Filters for Projects 

 

Filters are broken up into 2 sections:  Search and Report Template Filters.   

Search 

The Search section appears just above the Report Template section.  This 
section is primarily an open text field that allows the user to type in any text to 
match a name, description, or tag for any report template.  If desired, a checkbox 
exists to limit the search to only the report template’s related tags. 

Report Template Filters 

The Report Template Filters section appears just below the Search section.  This 
section allows a user to filter report templates by setting application, report 
template creator, date the report template was created, and date the report 
template was last modified. 

Refreshing Controls 

If a user modifies any setting while the Auto Refresh checkbox (Figure 131) is 
checked, a refresh operation will occur, and the software will display the updated 
report template set matching the new filter criteria on the right-hand side of the 
screen. 

Figure 131. Auto Refresh Checkbox 

 

 

 

Search Section 

Report Template Filters Section 
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If the Auto Refresh checkbox is not checked, no refresh operation will occur until 
the user clicks the Refresh button (Figure 132) located at the bottom right hand 
side of the screen. 

Figure 132. Refresh Button 

 

Perform the following steps to search for report templates.  

1. Log into the Celigo application.  

2. In the Start tab’s task screen, click Manage Data. The Data Management 
screen appears. 

3. Select the Report Templates Tab. 

4. Make adjustments to any search and filter entries as applicable (see 
descriptions above). 

5. Click Refresh. The Data display on the right side of the screen will display 
any found report template results matching the search parameters/filters 
specified. 

 

NOTE:  If the Auto Refresh checkbox is checked, step 5 
above is not necessary.  A refresh operation will be 
invoked for every change setting as a setting is 
changed. 

10.2 Clearing Search Selections 

The Reset Filters button (Figure 133) provides the user the ability to revert all the 
filters back to default settings which will display all projects on the right-hand side 
of the screen after a refresh is invoked. 

Figure 133. Reset Filters Button 

 

To clear search settings for report template  

• In Data Management screen in the Report Templates Tab, click the 
Reset Filters button (Figure 133). 
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10.3 Updating Search Selections 

The Report Templates Filters are set to have their selectable options and limits 
based on the entire database.  Application will therefore only display applications 
that are associated with the report templates in the database.  Created By filter 
and all other filters function similarly.  When the Celigo is connected to a network 
database (where it is possible for other users to be changing the data in the 
database you are connected to) the limits of your filters can change from when 
they have been loaded.  The Refresh Filters button (Figure 134) allows a user to 
refresh the limits of all their filters to the current state of the database.   

Figure 134. Refresh Filters Button 

 

 

NOTE:  The Refresh Filters button is only displayed 
when the Celigo is connected to a network database.  
This option is not present for Celigos connected to 
local databases. 

To update the bounds of the search settings for report templates  

• In Data Management screen in the Report Templates Tab, click the 
Refresh Filters button. 

10.4 Viewing Report Templates 

Report Templates are displayed to the user in a grid (Figure 135) on the right-
hand side of the screen. This section of the screen allows the user to view report 
templates matching the filters specified and enables the user to perform various 
functions on that data. 

Figure 135. Data Display Grid for Report Templates 

 

The report templates displayed in the grid are organized into columns that 
display various properties of the report templates.  These columns include:  
Check, Name, Application, Created By, Created Data, Last Modified, Description, 
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Type and Tags.  All columns other than Tags are sortable.  The button strip 
(Figure 136) at the bottom of the report templates display section displays the 
report template count of the found matching settings set.   

Figure 136. Button Strip for Report Templates 

 

10.5 Exporting Report Templates Report 

The Report Templates Tab allows a user to copy the current data result set as an 
image, text, or as an exported CSV file. 

Figure 137. Copy Button Dropdown Menu 

 

The Copy As Image button allows the user to copy the displayed report 
templates (as seen on the screen) as an image to the clipboard. 

The Copy As Text button allows the user to copy all report templates as text to 
the clipboard. 

Figure 138. Export Button 

 

The Export button (Figure 138) allows the user to save a text file of all report 
templates to disk. 

10.6 Selecting Report Templates 

Each report template item can be checked or unchecked.  Checking a report 
template item marks it to be included for a report template operation if one is 
chosen by the user.   

Figure 139. Report Template Operation Buttons 

 

Report template operations (Figure 139) can be found at the top left of the report 
template display section.  These operations include: Import, Export, Export and 
Delete, Create New, Edit, Delete, Add Tag, Remove Tag, and Clear All Tags.   

To check all projects in the report templates view 

• With the Report Templates tab selected in the Data Management screen, 
click the Check All button at the top right of the screen (Figure 140). 

Figure 140. Check All Button 
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To uncheck all report templates in the report templates view 

• With the Report Templates tab selected in the Data Management screen, 
click the Uncheck All Button at the top right of the screen (Figure 141). 

Figure 141. Uncheck All Button 

 

10.7 Importing Report Templates 

Figure 142. Import Button 

  

The Import button (Figure 142) allows the user to import projects into the Celigo 
database.  When you import report templates, you are importing to the database 
in XML format.  

To import report templates 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above). 

3. Click the Report Templates Tab. 

4. Click Import. 

A Select Report Templates to Import dialog box appears. The dialog box for 
importing projects is shown in (Figure 143). 

NOTE: The default directory for settings will be the following:  
C:\Users\<username>\Documents\Celigo\Report Templates 

Figure 143. Importing Report Templates Dialog Box 

 

5. In the Look in field, navigate to the folder that contains the report template to 
import. 

The system displays the report templates folders that contain a 
corresponding XML file. The file extensions for the XML files are as follows: 

• Report Template: .crp (Celigo Report Template). 
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6. Do one of the following to select the report template(s) that you want to 
import: 

• To select a single file: In the File name field, type a name for the report 
template that you want to import. 

• To select multiple files, Ctrl+click. 

7. Click Open. 

The system begins the import operation and a progress screen appears. 

The system imports the .crp files (XML format) to the database. 

Clicking Cancel will cancel the import operation. 

10.8 Exporting Report Templates 

Figure 144. Export Button 

 

The Export button (Figure 144) allows the user to export checked report 
templates from the Celigo database into a file format.  The Export and Delete 
button performs the same task as the export operation, but also will delete the 
checked projects that were exported after the export operation is successful. 

To export report templates 

1. Log into the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above). 

3. Select the Report Templates Tab. 

4. In the right pane, check the report templates you want to export. 

5. Click Export. 

6. Navigate to the designated or default folder (Figure 145), if applicable. 

7. Enter File name. 

8. Click Save. 

Figure 145. Exporting Report Template Dialog  
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NOTE: The default directory for settings will be the following:  
C:\Users\<username>\Documents\Celigo\Report Templates 

• Report Template: .crp (Celigo Report Template). 

10.9 Deleting Report Templates 

Figure 146. Delete Button 

 

The Delete button (Figure 146) allows the user to delete checked Report 
Templates from the Celigo database. 

To delete report templates 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above). 

3. Select the Report Template Tab. 

4. Search as needed to find the items you want to delete (section 9.1). 

5. In the right-hand pane check the detail items that you want to delete. 

To do this, left-click the checkbox to the left of the report template or select 
the Check All button (Figure 140), as applicable. To uncheck all, select the 
Uncheck All button (Figure 114). 

6. At the top of the projects view in the Report Templates Tab, click Delete. 

The system deletes all check marked items from the database. 

10.10 Tagging Report Templates 

Figure 147. Add Tag Button 

 

The Add Tag button (Figure 147) allows the user to add a tag to checked report 
templates.  When first clicking on the Add Tag button, a dialog will appear asking 
the user to type in a new tag.  As the user types a tag, a list will appear of tags 
matching the text typed if any exist.  Once the tag has been entered, the user 
clicks OK to complete the operation and then a tag will appear next to the 
checked items. 

Figure 148. Add Tag Selection Dialogs 
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To tag report template  

1. In the Start tab, in the task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above) with the files and 
folders that the logged-in user has permission to view (by means of the 
Scientist or Local Administrator permission selected when the user profile 
was created). 

2. In the report templates view of the Report Templates Tab, check all report 
templates that you want to associate a tag with. 

To do this, left-click the checkbox to the left of the report template or select 
the Check All button (Figure 140), as applicable. To uncheck all, select the 
Uncheck All button (Figure 141). 

3. Click the Add Tag button (Figure 147) and the Tag Selection dialog (Figure 
148) will appear. 

4. In the Tag Selection dialog, enter a new or existing tag to associate with all 
the checked projects to and click OK. 

As text is typed, all matching tags will be displayed in dropdown. 

5. After the OK button is pressed, the tag is associated with all checked items. 

10.11 Removing a Tag from Report Templates 

Figure 149. Delete Tag Button 

 

The Delete Tag button (Figure 149) allows the user to delete a tag from checked 
report templates.  When first clicking on the Delete Tag button, a dialog will 
appear (Figure 150) asking the user to type in a tag to remove.  As the user 
types a tag, a list will appear of tags matching the text typed if any exist.  If a tag 
is typed that is associated with the checked report templates, that tag will be 
removed when the user clicks OK.  If a tag is typed that is not associated with the 
checked report templates, the data’s tags will remain unchanged. 

Figure 150. Delete Tag Selection Dialog 
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Figure 151. Delete All Tags Button 

 

The Delete All Tags button (Figure 151) allows the user to delete all tags from 
checked report templates. 

To remove a specific tag from report templates  

1. In the Start tab, in the task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above) with the files and 
folders that the logged-in user has permission to view (by means of the 
Scientist or Local Administrator permission selected when the user profile 
was created). 

2. In the report template view of the Report Templates Tab, check all report 
templates that you want to dissociate a tag from. 

To do this, left-click the checkbox to the left of the report template or select 
the Check All button (Figure 140), as applicable. To uncheck all, select the 
Uncheck All button (Figure 141). 

3. Click the Delete Tag button (Figure 146) and the Tag Selection dialog will 
appear. 

4. In the Tag Selection dialog, enter an existing tag to dissociate from the 
checked report templates to and click OK. 

As text is typed, all matching tags will be displayed in dropdown. 

5. After the OK button is pressed, the tag, if it is found associated with the 
checked items, is removed from the item. 

To remove all tags from report templates  

1. In the Start tab, in the task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above) with the files and 
folders that the logged-in user has permission to view (by means of the 
Scientist or Local Administrator permission selected when the user profile 
was created). 

2. In the report templates view of the Report Templates Tab, check all report 
templates that you want to clear all tags from. 

To do this, left-click the checkbox to the left of the report template or select 
the Check All button (Figure 140), as applicable. To uncheck all, select the 
Uncheck All button (Figure 141). 

3. Click the Delete All Tags (Figure 151) button. 

4. After the button is pressed, all tags are removed from all report templates 
currently checked. 
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11. Data Administration 

Figure 152. Data Management Summary 

 

The Data Management screen is broken into five separate views: Data, Projects, 
Settings, Report Templates and Summary.  The Summary Tab (Figure 153) 
displays to the user a database summary and other miscellaneous administration 
information for the Celigo database.  The Summary Tab is only displayed to local 
administrator users and is broken up into 4 areas:  Database Summary, Over 
Time, Folder Breakdown, and Created by Breakdown. 

Figure 153. Summary Tab in Data Management 

 

11.1 Viewing Database Summary Information 

The Database Summary displays summary information for the database that the 
Celigo software is connected to.  The data shown here contains connection 
information, count information for each data and setting item, and storage space 
information. 
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Figure 154. Database Summary Stats 

 

To view Database Summary Information 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above). 

3. In the Data Management screen, click the Summary Tab (Figure 153).  The 
summary information will appear on the left side of the screen. 
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11.2 Viewing Over Time Information 

Figure 155. Over Time Data Display 

 

The Over Time section (Figure 155) displays up to a year’s worth of various 
information for the Celigo database.  Charts for the following can be displayed:  
Used Space, Database Available Space, Filestream Available Space, Plates, 
Scans, Scan Results, Experiments, Analysis Settings, and Classification 
Settings. 

To view Over Time Information 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above). 

3. In the Data Management screen, click the Summary Tab.   

4. In the right side of the screen, select the Over Time option you want to have 
a report for. 

5. Optionally, you can copy the chart information currently displayed as an 
image to the clipboard by clicking the Copy to Clipboard button (Figure 156) 
in the top right of the screen. 

Figure 156. Copy to Clipboard Button 
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11.3 Viewing Folder Breakdown Information 

Figure 157. Folder Breakdown Data Display 

 

The Folder Breakdown section (Figure 157) displays what portion of the Celigo 
database resides in each Celigo folder.  Charts for the following can be 
displayed:  Size, Plates, Scans, Scan Results, Experiments, Analysis Settings, 
and Classification Settings. 

To view Folder Breakdown Information 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above). 

3. In the Data Management screen, click the Summary Tab.   

4. Select the Folder Breakdown button to display the Folder Breakdown screen. 

5. In the right side of the screen, select the Folder Breakdown option for which 
you want to create a report. 

6. Optionally, you can copy the chart information currently displayed as an 
image to the clipboard by clicking the Copy to Clipboard button (Figure 156) 
in the top right of the screen. 



Nexcelom Celigo® Cytometer Administrator Guide Data Administration 

97 of 136 

11.4 Viewing Created by Breakdown Information 

Figure 158. Created by Breakdown Data Display 

 

The Created by Breakdown section (Figure 158) displays what portion of the 
Celigo database was created by each user.  Charts for the following can be 
displayed:  Size, Plates, Scans, Scan Results, Experiments, Analysis Settings, 
and Classification Settings. 

To view Folder Breakdown Information 

1. Log in to the Celigo application. 

2. In the Start tab’s task screen, click Manage Data. 

The Data Management screen appears (Figure 101 above). 

3. In the Data Management screen, click the Summary Tab.   

4. Select the Created By Breakdown button to display the Created By 
Breakdown screen. 

5. In the right side of the screen, select the Created By Breakdown option you 
want to have a report for. 

6. Optionally, you can copy the chart information currently displayed as an 
image to the clipboard by clicking the Copy to Clipboard button (Figure 156) 
in the top right of the screen. 
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12. Managing Plate Profiles 

Plate profiles are the plate formats that are used for scanning various plate and 
flask types on the Celigo cytometer. 

You manage plate profiles in the Plate Profile Management window. Managing 
plate profiles consists of viewing, deleting, importing, and exporting. 

All users have the permissions to view plate profiles. 

The following are permission levels and the associated actions that can be taken 
on plate profiles: 

• Scientist – Can view only active plates 

• Local Administrator – Can view active and deleted plates, and can import, 
export, and delete plates 

For more information on user permissions, see Adding a User section 3.1. 

12.1 Viewing Plate Profiles 

To view plate profiles 

1. In the Start tab, select Administration > Manage Plate Profiles. 

The Plate Profile Management window appears (Figure 159) with the first line 
item highlighted. The following figure shows the display for users with Local 
Administrator permissions. 

Figure 159. Plate Profile Management Window 

 

The Plate Profile Management window (Figure 159) displays the list of all 
plate profiles, with their specifications. 

2. Scroll to view any plate profiles not in view. 

3. If you want to view a well layout, click the name of the applicable 
plate profile. 

The well layout appears in the Plate Profile Preview section. 

Plates that 
the current 
user has 
permissions 
to view (only 
active plates 
vs. also 
deleted 
plates) 

Only Local 
Administrators can 
see these buttons 
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12.2 Deleting Plate Profiles 

 

NOTE: Deleting plate profiles requires Local Administrator 
permissions. 

To delete a plate profile 

1. Locate the plate profile that you want to delete by scrolling to it in the Plate 
Profiles list per Viewing Plate Profiles section 12.1. 

2. In the Plate Profiles pane, click the plate profile you want to delete so that it 
is highlighted. 

3. Click Delete. 

A Confirm Delete message box appears similar to the following (Figure 160). 

Figure 160. Confirm Delete Message Box 

 

4. Click Yes. 

The system does one of the following: 

• If a plate profile is requested to be deleted and has not yet been used for 
imaging, the system deletes the profile. In the future, the plate will not be 
listed in the Enter Plate Details screen. 

• If the plate profile is requested to be deleted and has been used for 
imaging, the system only marks the plate profile as deleted. In the future, 
the plate will not be listed in the Enter Plate Details screen, but any 
analysis and results associated with that plate will be viewable. 

12.3 Importing Plate Profiles 

 

NOTE: Importing plate profiles requires Local 
Administrator permissions. 

When you import a plate profile (also called a plate definition), you are importing 
into the database in XML format. 

To import a plate profile 

1. In the Plate Profile Management window, click Import. 

The Open dialog box appears (Figure 161). 
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Figure 161. Import Plate Profile – Open Dialog 

 

2. In the Look in folder, navigate to a folder that contains the plate profile 
to import. 

The system displays the plate profile folders that contain a 
corresponding .cpd (Celigo plate data) file (XML format). 

3. In the File name field, type a name for the plate profile that you want to 
import. 

4. Click Open. 

The system begins the import operation and a progress screen appears. 

The system validates the .cpd (Celigo Plate Definition) file (XML format) and 
then imports it to the database. If there were no errors, you will see the 
added plate profile in the Plate Profiles pane. 

Clicking Cancel will cancel the import operation. 

12.4 Exporting Plate Profiles 

 

NOTE: Importing plate profiles requires Local 
Administrator permissions. 

When you export a plate profile, you are exporting from the database to a hard 
drive in XML format. 

To export a plate profile 

1. Locate the plate profile that you want to export by scrolling to it in the Plate 
Profiles list per Viewing Plate Profiles section 12.1. 

2. In the Plate Profiles pane, click the plate profile you want to export so that it 
is highlighted. 

3. Click Export. 
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A Save As dialog box appears (Figure 162). 

Figure 162. Export Plate Profile – Save As Dialog 

 

4. In the Save in menu, navigate to a folder location. 

5. In File name, type a filename for the file. 

6. Click Save. 

The system saves the plate profile to the selected folder in XML format with 
a .cpd (Celigo Plate Definition) file extension.
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13. Database Access 
Perform the following procedure to set up access permissions to the Celigo 
database on customer instruments. 

13.1 Preparation 

Start with a blank system. This system will have some prerequisites installed, 
specifically SQL Server with the default Celigo user account configured as a SQL 
Server Administrator allowing access to the management tools and our 
application. The system (Computer name) in the following example is called 
Celigo-PC-###. 

Figure 163. System Information 

 

 

13.2 Procedure 

 

CAUTION: This procedure is to be performed by 
qualified Information Technology personnel only. 
Failure to perform this procedure correctly can 
delete the current database and all subsequent data 
will be lost. 

1. Make sure that you have performed the steps in Preparation section 13.1. 

 

CAUTION: Do not delete the original Celigo account 
(admin account for older Celigo models) or make 
any changes to it until you have performed this 
procedure and confirmed that the users are able to 
log in to SQL Server Management Studio and 
launch the Celigo application. 
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2. In SQL Server Management Studio, connect to the local database as follows: 

a) Open SQL Server Management Studio. 

Figure 164. SQL Server Management Studio Location in Start Menu 

 

b) Make the following selections: 

• Server type – Database Engine 

• Server name – (local)  

• Authentication – Windows Authentication  
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Figure 165. SQL Server Connect to Server Login 

 

c) Click Connect. 

3. In SQL Server Management Studio, navigate to security\logins folder. 

4. Right-click Logins and select New Login. 

Figure 166. Creating a New Login 

 

5. In the Login name field (Figure 167), type the fully qualified user or group 
name (including the domain) of the user or group to which you want to 
provide access, as shown in the following figure. In this example, the new 
user is DBPROBLEMTESTER\Test Admin. You can also use the Search 
button to search for a user or group in your active directory. 
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CAUTION: Be sure to keep the Default database 
selection as master. This will allow you to log in if the 
database is somehow removed or modified. 

Figure 167. New Login Window 

 

On the Server Roles page (Figure 168), keep public and sysadmin selected. 
Sysadmin will allow the new user full access to all management functions. 
Sysadmin should be reserved for the Superuser only.   

Note:  Only the Sysadmin can select the Recover Free Space button.  

It is recommended to define user roles and map the user permissions (i.e., select 
the Securable and then set, Grant, With Grant, and Deny, specific permissions).  

Note:  DB_Owner role is set to allow user to change the database settings, but 
cannot create or delete database permission.   
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Figure 168. New Login User Roles 

 

6. Test that the new user is able to log in to Microsoft SQL Server Management 
Studio and launch the Celigo application. 

Note:  In order to test the new user login ability, logout of Windows and login 
as the new user.  

7. Repeat steps 4 through 6 for each user or group that you want to give 
database access. 

13.3 Troubleshooting 

If the Windows Security dialog appears (Figure 169) at any time it may be 
because the instrument is not yet on the domain and/or the login credentials do 
not have access permissions. 
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Figure 169. Windows Security Prompt 

 

If you are planning to rename the computer, please be advised that this may 
cause the local machine login credientials for sql server to break and that the 
logins may need to be deleted and re-added to allow for the logins to access the 
database after the computer re-name. 
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14. SQL Authentication 

This section provides the procedures for setting up SQL Authentication mode for 
the Celigo database in the case you prefer to use that mode of authentication 
instead of the Windows login mode. There are only two major steps involved: 
creating a database login and adjusting the QueryEngineConfig.xml file. After 
that, you should be able to start up the Celigo application and it will guide you 
through the rest. The software will ask you to enter the credentials for the SQL 
login you created and then restart itself. If everything was entered correctly, the 
software will encrypt the login credentials in the QueryEngineConfig.xml file and 
you will be able to start using the Celigo. 

NOTE: SQL Authentication method is only available in software versions 3.2 
and later. 

14.1 Create a SQL database login 

Create a login following the steps from above in section 13.2(Procedure) with the 
only difference being we need to select SQL Server Authentication (See Figure 
166, Figure 167, and Figure 168) and give it a password. 

14.2 Setup the QueryEngineConfig.xml file 

Perform the following steps to setup the Celigo database in SQL 
Authentication mode. 

1. Open and edit C:\ProgramData\Nexcelom 
Bioscience\Celigo\ConfigFiles\QueryEngineConfig.xml. 

2. Add in a new setting element with the following values inside of the 
section element:  

      <setting key=IsSqlAuthenticationMode> 

          <string>true</string> 

      </setting> 

3. Save File 

Path: C:\ProgramData\Nexcelom Bioscience\Celigo\ConfigFiles 

4. Copy edited file 

5. Paste copied file into both Backup folders One and Two (Figure 170) 
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Figure 170. Config File Backup Folders 

 

6. Now start the Celigo application. Once you do this you should see a 
prompt asking for the username and password that you entered in 
section 14.1 (Create a SQL database login). 
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15. Database Maintenance 

To ensure proper Celigo cytometer functionality, reasonable performance, and 
the ability to retrieve backup files, periodic database maintenance tasks must be 
performed by the person assigned the administrator role for the system. 

Database maintenance consists of the following main tasks. Please familiarize 
yourself with the steps for each task and keep this document close to the Celigo 
server for reference while performing the tasks: 

• Deleting Unneeded Files from the Celigo Data Drive 

• Freeing Up Data Drive Space from Deleted Plates, Scans, or Scan Results 

• Scheduling Database Backups and Maintenance Tasks 

In the event that data is lost, Celigo field service personnel will be able to retrieve 
the data from the backup files. 

• Restoring Database Backups 

• Defragmenting the Data Drive 

• Anti-virus Rule Recommendations 

 

NOTE: The displays in this section show backup to the 
C drive. It is highly recommended, however, that you 
instead back up to a USB 3.0 external drive or network 
location. 

15.1 Deleting Unneeded Files from the Celigo Data Drive 

 

CAUTION: There are several large files used by the 
operating system that should not be removed. Check 
with your IT Administrator before removing files that 
you are not sure about. 

By deleting unneeded files from the Celigo data drive, you create free space, 
increasing Celigo computer speed and reliability. This section describes how to 
delete the following files that you determine are not needed: 

• Database backup files 

• Plates, scans, or scan results files 

• Temp directory files 

• Miscellaneous files and directories 

15.1.1 Deleting Database Backup Files 

Database backup files typically end in .bak and are extremely large, usually 
greater than 1 GB and often greater than 100 GB. The Celigo cytometer uses the 
C:\backup directory to store backups of application configuration files.  
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NOTE: Define a strategy for backing up important data 
for storing off of the Celigo C:\ (and D:\ if applicable) 
drives. Consider keeping three months’ worth of 
monthly backups, a month's worth of weekly backups, 
and a week's worth of nightly backups. (For the backup 
types and reasons, see Scheduling Database Backups 
section 15.3). This strategy will protect against loss of 
data and ensure that you are not keeping more large 
files than you will likely need. 

To delete database backup files 

• Right-click the backup file and select Delete. 

• If applicable, also go to your Recycle Bin and remove the files using the 
same instructions. 

The space from the deleted file immediately becomes available for use. 

15.1.2 Deleting Plates, Scans, or Scan Results 

Make sure to regularly delete any plates, scans, and scan results that are not 
necessary to ongoing projects; the image data accumulates quickly. The images 
captured during a scan are large files, accounting for more than 90% of the disk 
space that the Celigo application uses. The plates, scans, and scan results are 
stored in an SQL server database. 

 

NOTE: For Celigo prior to v3.0, the deletion of plates, 
scans, or scan results requires a subsequent 
checkpoint operation to free up the space from the 
deletion; your deletion of the other types of files 
described in this section will immediately result in the 
freeing up of data drive space operation. 

To delete plates, scans, or scan results 

1. Do one of the following: 

• If you want to archive the plates, scans, or scan results for possible 
future use, archive them per Exporting Plates, Scans, or Scan Results at 
section 7.8. Then continue to step 2. 

• If you do not want to archive the plates, scans, or scan results for 
possible future use, continue to step 2. 

• If you want to immediately request that the system begin freeing up 
space from the deleted files, click the Recover Free Space button at the 
bottom right of the Data Management window (Figure 62). 

Note: Recover Free Space button is only available to the Sysadmin user.  

2. Delete the plates, scans, or scan results from the Celigo drive and free up 
the space from the deleted files by performing Deleting Plates, Scans, Scan 
Results, or Settings section 7.10 and 9.9. 
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15.1.3 Deleting Miscellaneous Files and Directories 

Delete from the Celigo data drive any additional miscellaneous files and 
directories that you have determined are not needed. 

 

CAUTION: There are several large files used by the 
operating system that should not be removed. Check 
with your IT Administrator before removing files that 
you are not sure about. 

To delete miscellaneous files and directories 

Right-click the unwanted file and select Delete. 

The space from the deleted file immediately becomes available for use (may 
have to clear from the Recycle Bin first). 

15.2 Freeing Up Data Drive Space from Deleted Plates, 
Scans, or Scan Results 

For Celigo Software Prior to v3.0: 

When you delete plates, scans, or scan results from the Celigo data drive (see 
section 7.10), space is not yet freed up for use until the system performs a data 
drive space free-up process, called a checkpoint. Specifically, during a 
checkpoint process, the SQL server recovers deleted data blocks to the Windows 
file system at a gradual rate as to not impact the computer’s processing power.   

For Celigo Software v3.0 and Higher (And SQL Server 2012 or newer): 

Checkpoints are automatically issued during deletion operations for Celigo 
Software v3.0 and higher. In addition, to speed up the free-up process, a 
Recover Free Space operation was provided that will immediately recover the 
deleted data blocks. This operation requires a large amount of resources and is 
recommended to be run only during times of non-operation.  This operation is 
only available to users running their Celigo with an SQL Server 2012 or newer 
database. 

It is recommended to define a maintenance schedule as to when to click the 
Recover Free Space button.  To perform this too infrequently may mean it will 
take a great deal of time to recover the database’s free space.  

You can immediately start the freeing up of data drive space at any time. 

 

NOTE:  A checkpoint operation freeing up space from 
deleted plates, scans, or scan results may take several 
days for the system to complete, regardless of whether 
you perform an immediate checkpoint request or 
schedule it. 

To immediately start the freeing up of data drive space 

• Click Recover Free Space (Figure 171) at the bottom of the Data 
Management window. 
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Figure 171. Recover Free Space Button 

 

 

NOTE:  The freeing up of space (recover free space 
operation) requires a large amount of resources and is 
recommended to run only during times of non-
operation.  This operation is only available for use with 
SQL Server 2012 or newer. 

15.3 Database Manual Backup 

Perform the following procedure to manually back up the database. 

15.3.1 Procedure 

 CAUTION: This procedure is to be performed by 
qualified Information Technology personnel only. 
Failure to perform this procedure correctly can result 
in failed backups for the database or even delete the 
current database. 

1. Make sure that you have performed Database Access section 13. 

2. In SQL Server Management Studio, connect to the local database per 
section 13.2.  

3. Select the database that you want to back up. Typically this will be called 
Celigo, but it is possible there can be other names. Right-click the database 
name and select Tasks > Backup (Figure 172). 
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Figure 172. Back Up Task 

 

The Back Up Database - name of database window (Figure 173) appears. In 
the Source section, the database field will already be populated with the name 
you right-clicked. 
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Figure 173. Back Up Database Window 

 

 

4. Make the following selections: 

• Backup type: Full 

• Destination: Disk 

5. If there are any unwanted directories listed under Destination, click on them 
and click Remove. 

6. Click Add. 

7. Click the… button to browse for a location to save the backup to. 

8. Once the target location is found, give your backup a name (filename.bak) 
and click OK. 

 

NOTE: For maximum backup speed, is highly 
recommended that you select the USB 3.0 external 
drive as the file path. The database may be directly 
backed up to the network or copied from a USB 3.0 to 
the network for maximum data safety. 

9. Click OK again and you will return to the Back Up Database window and see 
your location has been added to the Destination list. 

10. In the left-hand pane, select Options: Backup pages. 

For maximum backup speed, it is highly recommended that you select the network file location or a 
USB 3.0 external drive as the file path. 
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The default options (e.g., Backup options) are adequate for typical backup 
operations. Change the entries as needed. 

11. Click OK. 

The backup starts. This operation can take a large amount of time depending 
on the backup size. 

15.4 Scheduling Automatic Database Backups 

Perform a database backup regularly for use as recovery files in the event that a 
hard drive fails. This activity is separate from the recommended periodic deletion 
of unnecessary data and archiving of data for longer term storage. 

The two types of backup strategies that accomplish this approach are: 

• Full backup 

• Differential backup 

By combining these two backup strategies to overlap throughout the week, the 
Celigo data will be protected from serious loss. The strategy described below will 
copy all the data except the scans acquired since the last backup to the day of 
the failure. To supplement the backup strategy, export important scans to an 
archive location soon after they have been acquired. 

15.4.1 About Full Backups 

There are several different types of full backups. The simplest form is sufficient 
for Celigo data backup purposes. The full backup described below will copy all 
data and configuration information into a single backup file that you move to an 
alternate archive location and can use to recover from a data drive catastrophic 
failure. 

 

NOTE: A full backup can take 8 hours or longer to 
complete and cannot be performed while other database 
activity is occurring. It is best to perform a full backup on 
late Saturday night, which will allow for the backup to 
run through Sunday if necessary without impacting the 
database access too much. 

15.4.2 About Differential Backups 

Differential backups archive all the data that have changed since the last backup 
was performed. These backups can be overlaid on top of full backups to provide 
a complete data set without requiring the same amount of down time or disk 
space. 

You should perform a differential backup nightly to ensure that all scanned data 
is protected from loss. Like the full backup, a differential backup must be run 
without other activity on the system and can last up to a few hours to complete. 
Therefore, schedule differential backups to run when the system is not being 
used; very busy labs could get away with running this type of backup every other 
day if the risk of data loss is a lower priority than a few hours of down time, but 
this is very risky. 
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15.4.3 Checking the SQL Server Agent Service 

To enable automatic backups, the SQL Server Agent Service must be enabled, 
allowing the scheduling setup to be successful. 

1. Click Start. 

2. Type services.msc 

3. Click on the Services application that appears. 

4. In the Services pane, double-click SQL Server Agent (MSSQLSERVER). 
The SQL Server Agent (MSSQLSERVER) Properties window appears 
(Figure 174). 

5. In the Startup type menu, make sure that Automatic is displayed. If it is not 
displayed, select it and click OK. 

6. If the status for SQL Server Agent (MSSQLSERVER) is not already Started, 
right click on it and click Start. 

Figure 174. SQL Server Agent (Service) Properties 

 

If you plan on choosing a network location as the target for scheduled database 
backups, the SQL Server Agent service must be run with an account that has 
access to the network location. By default, the service runs with a local SQL 
account. Do the following to run the service as a different user. 

7. Open the SQL Server Agent service properties (Figure 174). 

8. At the top, click the Log On tab. 

9. For the This account field, type the fully qualified user name (including 
domain) of the account that has access to the network location. Otherwise 
you can click the Browse button to search your active directory for the 
desired account. 

10. Type in the password for the selected account twice and click OK. 

11. Restart the service by right clicking on it and choosing either Restart or 
Start. 
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If you plan on choosing a network location as the target for manual database 
backups, repeat the above steps for the service SQL Server (MSSQLSERVER). 

15.4.4 Scheduling Full or Differential Backups 

The same basic steps are performed for either a full or differential backup, and 
are presented for both cases below in a single procedure. Perform the procedure 
two times – once for scheduling a full backup, and then again for scheduling a 
differential backup. 

To schedule full or differential backups 

1. Check that the SQL Server Agent service is set to Automatic per section 
15.4.3. 

2. Open Microsoft SQL Server Management Studio, right-click the Maintenance 
Plans folder (Figure 175) and select New Maintenance Plan. 

Figure 175. SQL Server Maintenance Plans 

 

3. The New Maintenance Plan Name box appears. Type in a name such as: 

• Celigo Full Backup 

• Celigo Differential Backup 

Click OK and the new Maintenance Plan will appear in the SQL Server 
window (Figure 176). 
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Figure 176. Maintenance Plan Editing 

 

4. In the upper right pane of the SQL Server window, double-click the 
Subplan_1 line item. 

The Subplan Properties dialog box appears (Figure 177). 

Figure 177. Subplan Properties Dialog Box 

 

5. In the Subplan Properties dialog box, make selections as follows: 

• In Name, enter one of the following, as applicable: 

o Celigo Full Backup 

o Celigo Differential Backup 

• Enter a description for the Subplan 

6. Click the Calendar control button (Figure 177)  

7. The New Job Schedule window appears (Figure 178) 
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Figure 178. New Job Schedule Window 

 

8. Schedule the full or differential backups. 

To do this, make selections as follows (Figure 179 or Figure 180): 

• Schedule type – Recurring 

• Frequency 

o Occurs – Weekly 

o Recurs every – 1 week 

o Full Backup typically 1 day chosen 

o Differential Backup typically multiple days chosen 

• Daily Frequency – 12:00:00 AM or whatever time you choose 
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Figure 179. New Job Schedule – Celigo Full Backup Example 

 

Figure 180. New Job Schedule – Celigo Differential Backup Example 

 

9. Click OK to accept the Job Schedule Properties settings. 

10. Click the next OK to accept the Subplan Properties (Figure 181). 

11. Click View > Toolbox to enable the Toolbox. You can move it to wherever is 
most convenient for yourself.  
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Figure 181. Backup Subplan Dialog 

 

12. In the Toolbox under Maintenance Plan Tasks, drag the Back Up Database 
Task onto the workspace to the right. 

13. Double-click the new Task icon to open the Back Up Database Task 
Window. 

14. In the Back Up Database Task window, make the following selections: 

• For full backups (Figure 181): 

− Backup type – Full. 

− Database(s) – Specific databases – Click the arrow on the right and 
select the Celigo database (Figure 182). 

− Folder: Enter or browse to target location to save backup, preferably 
to an external hard drive if one exists, or network location.   

NOTE:  It is not recommended to use the computer’s local drives. 

− Check Verify Backup Integrity checkbox. This will verify that the 
backup does not contain errors. 

• For differential backups (Figure 184): 

− Backup type – Differential. 

− Database(s) – Specific databases – Click the arrow on the right and 
select the Celigo database (Figure 182). 

− Folder: Enter or browse to target location to save backup, preferably 
to an external hard drive if one exists, or network location. 

NOTE:  It is not recommended to use the computer’s local drives. 

− Check Verify Backup Integrity checkbox. This will verify that the 
backup does not contain errors. 
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Figure 182. Database Selection Dialog 

 

Figure 183. Back Up Database General, Destination, and Options tabs for 
Full Backups 
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Figure 184. Back Up Database General and Options tabs for Differential 
Backups 

   

 

• Click OK to return to the maintenance plan editor window (Figure 185). 

Figure 185. Linking Tasks 

 

15. Save the maintenance plan by clicking the Save or Save As icon (Figure 
186). 

16. Right click on the Maintenance Plans folder and click Refresh. If you expand 
the folder you should see your saved maintenance plan as a file. (Figure 
187)  
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Figure 186. Celigo Backup Maintenance Plans 

 

Figure 187. Celigo Backup in Object Explorer 

 

17. Be sure to plug in and turn on an external USB 3.0 drive and leaving it 
connected to prevent disk letter changing 

15.5 Restoring Database Backups 

Perform the following procedure to manually restore a backed up database.  If 
you need to restore a database onto a network database server, please contact 
Nexcelom Customer Service. 
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15.5.1 Procedure 

 

CAUTION: This procedure is to be performed by qualified 
Information Technology personnel only. Failure to perform 
this procedure correctly can result in failed backups for the 
database or even delete the current database. 

1. Make sure that you have performed Database Access section 13. 

2. Open SQL Server Management Studio and login. 

3. Right-click Databases and select Restore Database… (Figure 188) 

Figure 188. Restore Database 

 

The Restore Database window appears (Figure 189). 
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Figure 189. Restore Database Window 

 

4. Select the Device radio button and then click the… button located to the 
right. The dialog in Figure 190 should appear: 

Figure 190. Select Backup Devices Dialog 

 

5. Click the Add button and browse to and select the backup file you intend to 
restore and click OK. The file you selected should be added under Backup 
Media. 

6. Click OK and return to the Restore Database window. 

7. In the Restore Database dialog under the Destination section, set the 
Database name to Celigo (Figure 191) or Celigo # (e.g., Celigo 2) if the 
database already exists.  



Nexcelom Celigo® Cytometer Administrator Guide Database Maintenance 

130 of 136 

8. Ensure that the appropriate database is checked in the Restore plan section 
(Figure 191).  

Figure 191. Restore Database Settings Example 

 

9. Click on Files in the left hand side, and make sure that the 3 files all have the 
same path (unless this is a network database) and are named the following: 

• Celigo.mdf 

• Celigo.ldf 

• Celigo.ImageStreams 

NOTE: If the restored database has a different name than the default Celigo 
then these files must be named with the restored database name 

• RestoredDBName.mdf 

• RestoredDBName.ldf 

• RestoredDBName.ImageStreams 
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Figure 192. Restore Database File Names 

 

10. Click the OK button to begin the restoration. 

• Database restoration can take some time. Original Celigos (Dell T3500) 
on average were able to do about 50GB in ~1 hour (meaning a 300GB 
database would take ~6 hours). All newer Celigo computers are able to 
restore at a much faster rate. 

• You will see a prompt when your database restoration has completed. 

11. After restoring a database, be sure to also apply the correct user permissions 
to enable users to access the database when logged in. See section 13. 

15.6 Defragmenting the Data Drive 

The Celigo cytometer’s data drive(s) can become fragmented over time from 
creation and deletion of large image files. As the disk drive fragments, its 
performance decreases, which can negatively impact the Celigo application's 
scan performance. To ensure that fragmentation does not become a 
performance problem, the hard drives should be defragmented approximately 
once every week. 

You can either defragment the data drive immediately or schedule a recurring 
defragmentation. Celigo computers are setup with default defragmentation 
schedules already in place.  If these have not been altered, then defragmentation 
is already occurring on the Celigo computer on a weekly basis. 

If your computer is a more recent Celigo computer, one of the hard drives is a 
SSD.  Do not perform defragmentation on SSD hard drives. 
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15.6.1 Defragmenting the Data Drive Immediately 

To defragment the data drive immediately 

 

NOTE: Be sure to perform or schedule defragmentation 
so that it occurs while the Celigo application is not 
acquiring images or analyzing plates. 

1. Using the Windows File Explorer, right-click on the data drive that you want 
to defragment and then select Properties. 

Model specific Data Drive:  

• If you have these models, T3500 and/or T3600, defrag the C:\ Drive. 

• For all other models, defrag the D:\ Drive only. 

The Properties dialog box shown appears (Figure 193). 

Figure 193. Disk Properties Window 

 

2. Click the Tools tab. 

3. In the Defragmentation section, click Defragment Now. 
The Disk Defragmenter dialog box appears (Figure 194). 
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Figure 194. Disk Defragmenter Window 

 

4. In Disk Defragmenter, select the (D:) disk you wish to defragment and click 
Defragment Disk. 

5. You can stop the Defragmentation process at any time by returning to this 
window and clicking Stop operation. 

15.6.2 Scheduling Defragmentation 

To schedule defragmentation 

1. Using the Windows File Explorer, right-click the data drive that you want to 
defragment and then select Properties. 

The Properties dialog box shown appears (Figure 193). 

2. Click the Tools tab. 

3. In the Defragmentation section, click Defragment Now (you click this button 
even for scheduling). 

4. Click Configure schedule and the Modify Schedule window opens. 

5. Check the checkbox for Run on a schedule. 

6. Adjust Frequency, Day and Time as needed. Be sure to schedule the 
defragmentation process for a time period where the Celigo is not being used 
or has low-usage. 

7. Click Select Disks, check the checkbox for all disks you wish to put on the 
defragmentation schedule and click OK. 

8. Click OK again to return to the Disk Defragmenter. 

9. Click Close and your defragmentation schedule is set. 
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15.7 Stopping Defragmentation 

To stop defragmentation 

1. If the Disk Defragmenter window is not open, open it by using the Windows 
File Explorer to right-click the drive that you want to stop defragmenting and 
select Properties. 

The Properties dialog box appears. 

2. Click the Tools tab. 

3. In the Defragmentation section, click Defragment Now. 

The Disk Defragmenter window appears. 

4. In the Disk Defragmenter window, click Stop operation (Figure 195). 

Figure 195. Stopping Disk Defragmentation 

 

15.8 Anti-Virus Rule Recommendations 

The following are anti-virus rule recommendations to prevent database corruption 
and loss of data. Please configure the antivirus to exclude all of the following 
items: 

SQL Server processes 

• SQL Server (MSSQLSERVER) 

o Process used for all database accesses to the Celigo database. 

• SQL Server Agent (MSSQLSERVER) 

o Process used for database tasks including database verification and 

automated backups. 

File Extensions: 

The below are all SQL Database file extensions. Database backups are of extension .bak 

• .mdf 
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• .ldf 

• .ndf 

• .trn 

• .bak 

The below are all (custom) extensions of data files that are generated/exported from the 
Celigo software 

• .cync 

• .cynp 

• .cynl 

• .cynr 

• .cas 

• .ces 

• .ccs 

• .crp 

• .cpj 

 

The below are all DENOVO FCS files 

• .fcs 

• .ice 

• .acs 

Folders: 

• C:\Program Files\Nexcelom Bioscience 

o Celigo software installation directory. 

• C:\Program Files\Microsoft SQL Server 

o Location of the master and default system databases. 

o This will cover all versions of SQL installed. 

• D:\ 

o Location of Celigo database. We recommend this drive only be used for integrated Celigo 

database use and that external documents are not stored here. 

• C:\ProgramData\Nexcelom Bioscience 

o Location of the Celigo software configuration files. 

Windows Updates: 

We do not manage Windows Updates on Celigo systems. By default, the Windows Updates settings are 

configured to update automatically once weekly, so if the computer is on your network, then the updates 

are controlled by either your WSUS server, or else just the default Windows Update servers. 
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